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CHAPTER

1

INTRODUCTION

Welcome to the Helix Mobile Producer User’s Guide from
RealNetworks®. This manual shows you everything you need to
know about this product, which enable you to convert audio and
video into streaming media for wireless devices such as mobile

telephones and personal digital assistants (PDAs).

Using Helix™ Mobile Producer powered by Envivio™, anyone can
create streaming media easily from a variety of sources. You can
convert from existing audio or video files, record directly from
audio/video (A/V) devices, or use these applications together with

Helix Server to broadcast and stream live content.

Whatis Helix?

Helix from RealNetworks is a universal digital media delivery platform. With
industry-leading performance, integrated content distribution, advertising,
user authentication, Web services support, and native delivery of many types
of media files (RealMedia™, Windows Media, QuickTime, MPEG-4, and
3GPP), Helix from RealNetworks is a robust digital media foundation that
meets the needs of businesses and networking service providers.

Helix Mobile Producer

With Helix Mobile Producer, you can format your video and audio content to
reach the world of wireless devices. This innovative encoding software enables
mobile operators and content providers to convert streaming media to a full
spectrum of standards for mobile products. Helix Mobile Producer is a key
component of RealNetworks’ end-to-end solution (encoding, serving, and
playback) for mobile multimedia, supporting both on-demand and live
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encoding and making it possible to generate content with the bit rates, frame
sizes, and other settings most suitable for mobile devices.

Standard and Professional versions

Helix Mobile Producer gives you the ability to encode streaming audio or

video presentations as files. Helix Mobile Producer Live is delivered in two
versions, Standard and Professional. The Professional edition includes the
following additional features:

- Command-line interface
« SNMP monitoring

« Batch encoding through the graphical interface

Why Use Helix Mobile Producer?

Quality

When it comes to 3GPP mobile encoding, Helix Mobile Producer does it all.
This product is ideal for either live or on-demand content and will convert
most common types of video and audio to standards-compliant 3GPP
formats. This section discusses the features and capabilities of this software in
terms of two key areas: quality and productivity.

Helix Mobile Producer provides support for a range of encoding technologies
that enable high-quality media delivery, using the features described in the
following paragraphs.

MPEG-4 SVP (Simple Video profile) video

Stream or download high-quality video to users’ cell phones or PDAs, at bit
rates from 10 to 384 kilobits per second (Kbps). Helix Mobile Producer
supports the following MPEG-4 SVP levels:

level 0 up to 64 Kbps
level Ob up to 128 Kbps
level 1 up to 64 Kbps
level 2: up to 128 Kbps
level 3: up to 384 Kbps
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H.263 Profile 0 video

This is another standards-based codec that you can use to deliver good-quality
video at bit rates from 10 to 384 Kbps, but without the licensing requirement
of MPEG-4. Helix Mobile Producer supports the following H.263 Profile 0
levels:

level 10: up to 64 Kbps
level 20: up to 128 Kbps
level 30: up to 384 Kbps
level 45: up to 128 Kbps
H.264

Helix Mobile Producer supports the following H.264 baseline profile levels:

level 1: up to 64 Kbps

level 1b: up to 128 Kbps
level 1.2: up to 384 Kbps
level 1.3 up to 768 Kbps.

Note that the encoder limit for this
codec is 384 kbps. 768 kbps reflects the
limit for the level

Variable-bit-rate encoding

This feature enables the video codec to vary the bit rate throughout a clip,
depending on the type of content being encoded. With variable-bit-rate
encoding, the more action there is in a scene, the more bits are used for that
scene. This makes for a more consistent quality of video encoding for
downloadable content, while keeping download times as short as possible.

2-pass video compression
Double-pass encoding increases output quality by analyzing video data before
encoding the input video.

AMR audio

Using this feature, you can deliver high-caliber voice clips at bit rates ranging
from 4,750 to 12,200 bps.
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AAC-LC audio
AAC Plus audio
Enhanced AAC Plus audio

This feature enables you to deliver music and mixed-audio content at bit rates
from 8 to 128 Kbps. AAC provides better-quality audio than does MP3 at the
same bit rate.

Video scaling

You can use imported video files to scale standard screen resolutions ranging
from QQCIF (88 x 72) to CIF (352 x 288).

Prefiltering

By cropping or making adjustments in frame-rate conversion, inverse-telecine,
deinterlacing, noise filtering, brightness, contrast, and gamma settings, you
can improve video quality.

Productivity

Helix Mobile Producer increases your productivity by providing support for a
number of media formats and tools that make automated media encoding

possible.

Input file support

With DirectShow and QuickTime 6 installed, Helix Mobile Producer can read
a variety of file types, including AVI, MOV, DV, MPEG-1, MPEG-2 (with an
additional DirectShow or QuickTime plug-in), MP3, MPEG-4, and WAV files.

XML job files

By using XML job files, you can define all of the settings for a given file-to-file
encoding job, making it easy both to edit the files and to reuse the same
settings for batch processing.

Command-line interface

A simple command-line interface enables you to create batch-processing
scripts or to wrap your 3GPP encoding into your own customized, automated
system.

Additional Documentation Resources

In addition to this manual, you might want to consult the following
RealNetworks books, the first three of which are available for downloading at
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the following Web address:
http://service.real.com/help/library/encoders.html.

« Introduction to Streaming Media

Start with this guide if you are new to streaming media or RealNetworks
products. Written for the beginning user, this book explains how to put
together a basic presentation using different production techniques.

RealNetworks Production Guide

This guide is the main reference manual for streaming media production.
Refer to the production guide for instructions and tips on producing
audio and video clips, as well as for complete information about using the
Synchronized Multimedia Integration Language (SMIL).

RealPlayer Scripting Guide

If you are a Web programmer, refer to this guide for instructions about
using JavaScript or VBScript with RealPlayer™ from RealNetworks. Using
these scripting languages, you can customize RealPlayer to turn it into
your own Internet jukebox, for example.

« Helix Server Administration Guide

The basic reference for the Helix Server, this guide explains how to set up,
configure, and run Helix Server to stream multimedia. You need this
guide only if you are running Helix Server yourself. You can download this
manual from the following Web address:

http://service.real.com/help/library/servers.html.

Technical Support

For general information about RealNetworks Technical Support, visit the
following Web page:

http://service.real.com
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2

STREAMING MEDIA BASICS

This chapter introduces you to streaming media and how you can
use Helix Mobile Producer to create streaming media. It gives you a
brief look at how streaming works, the different types of media that
you can create with Helix Mobile Producer, and the various

RealNetworks products that you use when streaming.

What is Streaming Media?

Before the advent of streaming media, users had to wait for media files, or
clips, to be downloaded from the Internet or from a network server before
they could play the clips. With streaming media, users can see and hear these
clips almost instantaneously.

A streaming clip consists of small packets of information that are sent over a
network connection. The user receives these information packets in a “stream”
and, using a player (such as RealPlayer from RealNetworks), experiences the
media piece by piece.

The mechanics of the streaming process are virtually invisible to the user. In
fact, the process is similar to viewing a film, with each data packet being
analogous to a single frame in a filmstrip. When a film is run through a
projector and displayed on a screen, the audience is not aware of each
individual frame they are seeing; rather, they experience the film as one
continuous flow. Similarly, when users receive and play streaming media clips
on their computers, what they experience is a continuous stream rather than a
succession of discrete data packets.

How is Streaming Media Created?

Helix Mobile Producer creates streaming media data packets by a process
called “encoding.” During encoding, the source media is transformed into
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streaming media through the use of “codecs” (compression/decompression
algorithms). The entire process is summed up in the following four steps:

1. Helix Mobile Producer receives the source media as a file, or as live audio
or video.

2. Helix Mobile Producer uses a codec to compress the media source’s data
into packets.

3. The data packets are streamed to the user over the Internet or an intranet.

4. At the user’s end, the same codecs are used to piece the media back
together so that the user can play the clip.

Working with Audio and Video Clips

Although for you the steps involved in encoding streaming audio are similar
to those involved in encoding video, there are some basic differences in the
way Helix Mobile Producer processes audio and video streams.

Encoding audio is simpler than encoding video. A basic streaming audio clip
is created by using an audio file or live audio source as the input. Helix Mobile
Producer uses various audio codecs to convert your standard audio input into
a format that can be streamed.

A more complex task for Helix Mobile Producer is converting standard video
input into streaming media. A video clip is created either by converting an
existing video file or by capturing a live video source, such as from a video
camera or a VCR, and sending it to your computer by way of a video capture
card. Helix Mobile Producer converts different attributes of the video—such as
frame rate, type of motion, and size of the image—into a video clip by using a
video codec. If the video also includes audio data, that must also be converted
by the audio codecs.
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Targeting Audiences

Before Helix Mobile Producer can compress the source data, it needs to know
something about the intended audience for the resulting media clip. An
audience is defined by the bit rate at which their computers can connect to the
Internet or a given network. For example, a person using a 56-Kbps dial-up
modem to connect to your media stream is a member of the 56K Modem
audience.

Single-Bit-Rate Streaming

Single Bit Rate

Real Media P'aﬁrﬂr

Because some data is lost during the compression process, picking the correct
audience is key in preserving as much of your source data as possible.

Other RealNetworks Products

Helix Mobile Producer is a member of the RealNetworks family of software
products. These components work in tandem with one another to create,
stream, and play your media clips:

» Helix Mobile Producer creates streaming clips for mobile devices.
» Helix Server streams the media clips to users.
« RealPlayer enables users to play the streamed media clips.

The following diagram illustrates how these RealNetworks products work
together.

RealNetworks Software Products

Server

- O

Helix Mobile Producer RealOne Player

oooooo
oooooo
Y
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Helix Server

Just as a Web server delivers pages to Web browsers over the Internet, Helix
Server serves streaming media clips to your audience. It enables users to
stream the media clips rather than download them. By streaming the content,
a user can begin to watch the clip almost immediately and doesn't have to
wait for the entire file to be downloaded.

There are two different ways to deliver your content: as an on-demand file or
as a live broadcast. On-demand delivery entails encoding your media content
before your audience needs it. With live broadcasting, on the other hand, the
media is being encoded at the same time that your audience is playing it. For
both types of delivery, you can use Helix Server in conjunction with Helix
Mobile Producer.

Client Software

A client, such as RealPlayer installed on a mobile device, plays the streamed
media. Note that with Helix Server, you can also deliver streaming content to
computers running Windows Media Player or QuickTime as their client
(player) software.
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3

SYSTEM REQUIREMENTS AND INSTALLATION

This chapter discusses the hardware and software requirements for
Helix Mobile Producer, and it explains how to install the products on a

computer running Microsoft Windows.

Note: Windows 2000 and Windows XP are the only operating
systems supported for use with Helix Mobile Producer.

System Requirements

The following table lists the hardware and software requirements and
specifications for installing and running Helix Mobile Producer or Helix
Mobile Producer Live on your computer.

Helix Mobile Producer and Helix Mobile Producer Live
System Requirements and Specifications

Category Item Requirements or specifications

Minimum Microsoft Windows 2000 or Windows XP

system Windows Pentium III equivalent or greater
requirements |operating 128 MB of RAM (256 MB recommended)

and support | system NTEFS is required for large files that cannot be

handled by a FAT32 file system
DirectX 8.1 or later

Optional Requirements:

DirectShow MPEG-2 Decoder to import MPEG-2
and

QuickTime 6.0 or later to import MOV and MP4 files
(QuickTime 6.5 recommended)

Graphics card | Color graphics card capable of 1024 x 768 resolution

Networking | Ethernet card

Supported | Video AVI, MOV, MPEG-1, MPEG-2, MPEG-4, DV
tmport Audio AIF, MP3, WAV
formats

11
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Helix Mobile Producer and Helix Mobile Producer Live
System Requirements and Specifications (continued)

Category Item Requirements or specifications
Supported Osprey 100 | Video: S-Video and Composite
capture Audio: None
devices Osprey Video: S-Video and Composite
200/210/220 | Audio: Analog RCA and XLR
Osprey 500 | Video: S-Video and Composite, IEEE 1394/DV, and
DV/500 DV SDI
Pro Audio: AES/EBU
Osprey 540 Video: S-Video and Composite, IEEE 1394/DV, and
SDI
Audio: Analog RCA and XLR, AES/EBU, and
Embedded SDI Audio
Techsmith Video: Screen capture only
Camtasia
Pinnacle Video: S-Video and Composite
PCTV Rave Audio: RCA
Philips Video: Webcam
ToUcam Pro | Audio: mono, 16-bit, 8 / 11.025 / 22.05 / 44.1 kHz
Export File format 3GPP, 3GPP2, 3GPP v6
MPEG-4 files, optionally prepared for RTP streaming
AMR
MP3
QCP (QCELP file format)
RealMedia

Warning! We do not support running of our encoders with a
third party encoder(s) on the same machine.

The primary reason is that other encoders do not have the
concept of resource sharing. Unlike Real encoders, which will
adapt to a constrained system environment by encoding at
lower complexity, or encoding fewer frames, the third party
encoders will dominate the system at the expense of our
encoders, therefore producing a bad result.
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Installing Helix Mobile Producer

This section explains how to install Helix Mobile Producer on your computer
and how to register your copy of the product with RealNetworks.

To install Helix Mobile Producer, you must have at least a “Power User” access
level.

Note: You should have received your license files through
email. If you are installing a trial or demo version, these trial
license files will expire 30-60 days after you receive them. If you
are installing a purchased copy, your license files will never
expire.

» To install and register Helix Mobile Producer:

1. Double-click the icon for the installer file,
helix_mobile_producer_11_windows_setup.exe, then read and follow the
online instructions displayed during the installation process.

2. Specify the path to the licensing file where indicated, and then click Next,
as shown in the following illustration.

5|

Please enter the path ta the license file you obtained far Heliz
Mobile Producer

Hellx.:‘

:Micensebhelis_mobilelyour_license.lic Erowse .. I

Click MNext to continue.
Click Cancel to exit Setup,

Cancal |

3. Follow the rest of the installation instructions.

Installing the SNMP Component

If you do not already have the Windows SNMP service installed, you will need
to install it from the Windows installation CD.

Note: The SNMP monitoring component of Helix Mobile
Producer is only available with Professional level licenses.

13
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If you are installing a Professional license and wish to install SNMP, we
recommend that you manually halt the SNMP service before installing, then
restart the service after installation is complete.

» To manually halt the SNMP service:

1. From the Windows Start menu, go to Programs>Administrative Tools and
open the Services application.

2. If SNMP is installed on your system, there will be two SNMP services
named "SNMP Service" and "SNMP Trap Service".
From the Services list, select these two services (one at a time) and click the
Stop Service button in the toolbar, or select Stop from the Action menu.

3. Run the Helix Mobile Producer installer (You can leave the Services
application running). Be sure to check the Install SNMP check box on the
third panel of the install.

After the installation is complete, you can restart the SNMP services.
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4

QUICK START

This chapter explains how to start Helix Mobile Producer. It introduces
key concepts that will help you encode audio and video from
prerecorded files or live media sources. It also explains the basic
workflow for encoding a media.
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Starting Helix Mobile Producer

To start Helix Mobile Producer, double-click the Helix Mobile Producer icon or
use the Windows Start menu. Programs are listed directly under
Start>Programs>Helix>Helix Mobile Producer.

Helix Mobile Producer Workspace

Frame-by-
frame controls Menus Preview panels Encode/Stop buttons

1ol

[ Helix Mobile Producr Professional Edition powered by Envivio 11.0 - (build#53

Fie Edt Mods Help

Input ~| 32288 Filtered Input ~| 32288

1]

— | 4|l 4|} '—_‘ 00:00:05.988 Encode Stop

EXPOI't type ———  Esport Type: | 3GPPYE multrate -

Tnput/Out BudioViden Streanms | Filters | Export Settings & Matadata |
Input Output
% File: [E-\Mediawise_352¢268_av.avi Browse [ Fis: [AMedictwse 352288 av.3on | Save fs..
I~ From: | Tor |
£ Devicss o |
Ao [Wore = Seitings
Yideo: e H| Seftings

= Dursion daysiisminsises.fiac

Configuration window

The Helix Mobile Producer workspace is composed of several panels, which
are described in the following paragraphs.
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» The upper window is divided into two preview panels. Each panel may

display one of the following:
- a preview of the original video input.
« a preview of the filtered input

- a preview of the encoded output after application of the selected
audience(s).

+ Of, NO preview
...and the left/right audio channels

« The horizontal bar in the middle of the workspace displays the frame-by-
frame controls and the encoding progression bar. It contains the Encode,
and Stop buttons.

» The lower window allows selecting the export type and has tabs for
configuring input/output, streams, and filters parameters, and for
defining export settings and Metadata.

Quick Concepts

This section describes key concepts that will help you understand how to use
Helix Mobile Producer effectively.

Media Sources

Jobs

A Helix Mobile Producer presentation can include one digital video source,
one digital audio source, or both. Note that input media sources can be either
existing files or media that’s “captured” live.

The job defines how to encode your clip or broadcast. It selects the media
inputs, sets the encoding properties, and defines the destinations, such as
whether to save the encoded stream to a clip, forward it to a server for
broadcast, or both.

For More Information: Chapter 6 explains how to define jobs
through the graphical application. See Chapter 9 for
information about specifying jobs on the command line.
Appendix B explains the job file syntax.

17
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Audiences

When you set up a job, you choose one or more audiences. An audience
defines several aspects of the encoding job. Most importantly, it defines the
bit rate at which a clip or broadcast streams. For a downloadable clip, the
audience selection affects the clip’s quality and file size. Selecting an audience
is therefore one of the most important decisions you make when encoding a
clip. Helix Mobile Producer predefines a number of audiences designed to fita
variety of streaming and downloading requirements.

For More Information: Chapter 5 explains how to select
audiences through the graphical application. Chapter 9 does
the same for the command-line application. You can also
create your own audiences, as explained in Appendix A.

Encoding

Encoding compresses digital media so that it takes up less space and can be
transmitted faster. The compression process identifies the essential
components of the input media and discards the superfluous parts.

Be aware that the addition of data such as hint tracks and headers to audio or
video streams during the encoding process results in the encoded files being
somewhat larger than the sum of the encoded media bit rates multiplied by
the duration of the file ((audio bit rate + video bit rate) x duration). This does
not affect the bit rate or quality of the media, because this additional data
remains on the server and is not streamed to the client.

Note: The hint track is required by the streaming server to
optimize the streaming experience. A 3GPP media file must
have a hint track to be properly streamed from most streaming
servers. The hint track is not required if the media file is to be
downloaded and played locally, however. To avoid having Helix
Mobile Producer add a hint track to such a file, clear the
Prepare for streaming check box on the Export settings and
Metadata tab before encoding the audio or video clip.
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Getting Started

This section outlines the main steps involved in preparing to encode audio or
video input: setting up input for offline or live encoding, choosing an
audience, and setting output options.

Basic Workflow

Perform the sequence of actions outlined in this section to encode media for
file output or broadcast output by using Helix Mobile Producer.

» To encode media with Helix Mobile Producer:
1. Set the export type

« The export type defines the selectable inputs and outputs, audiences
and encoder types.

2. Set input parameters:

» Select an input media source: file (offline encoding) or capture (live
encoding).

« For file input, select the file’s path. (If your input is an AVI file, you
would then choose how you want to open AVI files.)

« For captured input (for example, camera or VTR), select audio and
video input sources, and then set the duration.

3. Set output options:

« Specify the destination for file output.

« Specify the parameters for broadcast output.
4. Select audience(s):

« Select one or more audience from the Audience template list, then
adjust the values if necessary.

5. Set the filters
6. Set the export parameters and metadata.

7. Encode the input media (file or live).
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Setting Up the Export Type

You need to select a target export type to define the selectable inputs and
outputs, audiences and encoder types. Selecting an export type restricts
choices regarding encoder type and number of audiences, unavailable
parameters are grayed out.

You can export encoded files in any format listed in the following table.

File Formats Supported for Exporting

Format Description

3GPPv5 European third generation partnership project file format, release 5.
(single rate) |Includes definition of the IP-Multimedia System (IMS) and High
Speed Downlink Packet Access (HSDPA), assuring users full
multimedia application capabilities.

3GPP v6 European third generation partnership project file format, version 6.
Includes networking with Wireless Local Area Networks (WLAN),
Presence, speech enabled services, interpretability with other network
technologies, and use of new radio frequencies.

3GPP2 North American and Asian third-generation partnership project file
(single rate) |format

ISMA MPEG-4 ISMA 1 profile 0 format

Profile 0

AMR Adaptive multirate speech codec

QcCp Speech codec

MP3 MPEG-1 audio layer 3 file format

RealMedia |RealNetworks media file format

Setting Up Input and Output

Setting Up Source Files for Offline Encoding with Helix Mobile Producer
You need to specify a source file before you can start encoding offline input

media with Helix Mobile Producer.

Selecting a Source File

Use the following procedure to specify an input source file that you want to
encode.
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» To select a source file:
1. Click File>Open Input File.

2. Select an input source file.

Note: When you select a video source, the preview of the input
video is displayed in the Input preview panel. If you select an
audio source, a headphones icon is displayed.

Setting Up Capture Sources for Live Encoding
You need to specify live input sources before you can encode live media.

Note: Live encoding is only available with Helix Mobile
Producer Live.

Selecting a Media Source

The first thing you must do if you want to encode a live media stream is to
decide what source you will use for your input media, and then select that
source in the Input panel in the Helix Mobile Producer workspace.

» To set up captu re sources:

1. Select a video source from the list of available video capture devices.

Note: Only the first ten detected inputs are displayed.

Selecting a video capture device

* Devices
Audio: I Maone LI Settings |
Wideo: Philipz Tallcam Prao Camera; Video LI Settings - |
v Duration: Nnne

{ davs:hrsiming sec frac

Note: When you select a video source, a preview of the input
video is displayed in the Preview panel. Note that no output
preview is displayed for RealMedia encoding.

2. Select an audio source from the list of available audio capture devices.

Note: Only the first ten detected inputs are displayed.
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Selecting an audio capture device

{+ Devices
Audic: Mone | Settings |
: Mone ;
Hideo: FSB Lival Audio [BA00] Seftings - |
v Duration: l;'M'.Bd"? Wave Device dapshreming zec.frac

Note: For any given instance of live media that you want to
encode and broadcast, you might need to select only a video
capture source or only an audio capture source, and not both.

Setting Output Options

Using Helix Mobile Producer, you can encode input audio and video as output
files or live broadcasts.

File Output

You can specify the path where you want to generate the output file by
clicking the Browse button in the Output panel and then selecting the path to
the output directory.

Live Broadcast Output

You can use a streaming media server as a destination for encoded output.
When you use this method, the encoding and transmission of live media
directly to the streaming server and then straight to your audience occur
simultaneously. This is called live broadcasting.

You can use either of two modes for live broadcasts:
« RTP broadcast mode (for 3GPP, 3GPP2, and MP4 only)
« Helix broadcast mode (for RealMedia only)

For More Information: Refer to “Chapter 7: Broadcast”
beginning on page 33.

Encoding Input Media

As soon as you have specified the source media and set up encoding
preferences by selecting a template and adjusting encoding parameters (as
explained earlier in this chapter), you are ready to start encoding your media.
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Starting to Encode

To begin encoding, click the Encode button below the Output panel on the
Helix Mobile Producer workspace. When encoding begins, the progress bar
indicates the encoding status and the elapsed time, as shown in the following
illustration. Any time you want to stop the encoding process, simply click the
Stop button to the right of the Encode button.

Control Buttons and Progress Indicators for Encoding

|IIII 5% Encode | Shop |

Encoding progress bar Encode button Stop button

Partial Encoding

By default, Helix Mobile Producer encodes the entirety of whatever input
media it receives. There are, however, options you can use to encode only part
of an input file or to encode live input for only a specified amount of time.

Partially Encoding an Offline Media File

To encode only a part of an input file, select the From check box and then type
the start and end points you want for the encoding, as shown in the following
illustration. Note that these points are measured from the beginning of the
input file, in tenths of a second.

Partial encoding of offline media

Input

(¢ File: IE:'\Media'\\a\-"se_352>:288_av.avi Browsze... |
(IF From: [1:14.560 To: [1:35:20.135 )

Another option is to use the Set mark-in and Set mark-out buttons to specify
graphically the start point and end point for the encoding, respectively. See
these and other buttons in the following illustration.
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Frame-by-Frame Controls

Go to next frame Go to the end
Go to previous frame Set mark-in
Go to beginning 1 —‘ ’V r Set mark-out

leo| ||| 4] 4] p——r

Expaort Tope : | 3GPPYG -|

Time Limited Live Broadcast

After you have set the encoding process in motion for live media, Helix Mobile
Producer will, by default, continue encoding the live stream until either the
Stop button is clicked or the specified duration period comes to an end. To set
this latter option, select the Duration check box and then type whatever
duration period you want, as shown in the following illustration.

Setting the Duration of a Live Broadcast

+ Devices

Audio: I Périphérique audio USEB LI Settings - |
Wideo: I Philipz Tallcam Prao Camera; Video LI Settings - |

C|7 Dluration; |‘I:15:DD.DDE1 days:hrs:mins:sec.fraa
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AUDIENCES

Before you encode a clip or broadcast, you choose the audience or
audiences to use. For each audience, Helix Mobile Producer encodes
a separate stream based on the speed of the network connection or a
certain level of quality that you want to preserve. This chapter
explains how to use audiences.

Working with Audiences

An audience defines a range of parameters used to encode a clip or broadcast.
It defines the audio codecs, the video codec, the maximum frame rate, and the
maximum streaming bandwidth, for example. You can use the same audience
to encode a video clip or an audio-only clip.

Adding an Audience to a Job

Helix Mobile Producer provides a number of predefined audiences designed to
fit a variety of streaming and downloading requirements. You can add an
audience template to the encoding job, or remove it.

Note: You can only add multiple audiences to 3GPP v6
Multirate and RealMedia export types.

The lower panel of the Audiences palette lists the available audience templates.
Each template has a name that describes the audience, such as GPRS News,
and may list the template's average bandwidth usage. The upper panel of the
palette lists the audiences chosen for the job.

» To add an audience to the job:
1. Click the audience name in the lower panel.

2. Click the Up arrow button, a|.
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Note: To add multiple audiences to the same job, you can
choose only the audiences not listed as variable bit rate (VBR)
audiences. To delete an audience from the job, highlight the
template name in the upper panel, and click the Delete button,

.

Tip: To view the properties for an audience added to the job,
click the audience name. The audience properties are displayed
in the right panel.

Creating a New Audience for the Active Job

Creating a new audience

Note: If it is not a 3GPP v6 Multirate or a RealMedia export
type, you must first remove the existing audience before
adding a new audience.

» To create a new audience:
1. In the upper panel, click the New button, _+|
2. Modify this audience.

Choosing a Template Name

When you edit a template or create a new one, you can specify a name by
double-clicking on the audience name. The graphical application uses this
name to identify the template.

You can also use this name to specify the audience with the command-line
application. Helix Mobile Producer uses the template name as the file name
for the audience file, appending the .xml extension automatically.

Changing Audience Settings

You can edit any audience template to change it permanently. You can also
create a new template from an existing one to define your own audiences.

Note: These changes are recorded in the template and the
active job, but not in any previous jobs that also used the
audience template. To update an older job, edit the job file
manually. Or, import the job in the graphical application,
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delete the existing audience or audiences, then add the new
audiences.

Changing Audience Values for the Active Job

To change the audience properties for an active job:

1. Add the audience to your job as described in “Adding an Audience to a
Job” on page 25.

2. Click the audience name in the upper audiences palette to display the
audience properties.

3. You can then change the audience settings.
4. Optionally, you can click the Up arrow button, =] to save the modified
audience as a template.
Editing, creating or deleting an Audience Template

1. Select an audience template from the list. This displays the template's
settings in the right-hand side of the window.

Tip: Within the list, templates are ordered according to the
audience's average streaming speed or quality setting.

2. You can then perform any of the following actions:
a. Edit the settings for the template as described in Chapter 8.

b. Click the ‘Delete’ button, _HI to delete the selected template.

Deleting an Audience

» To delete an audience:

1. Select the audience you want to delete.

2. Click the Delete button, ﬂ

Audience Files

Helix Mobile Producer stores audience information in an XML-formatted
audience file that you can edit by hand. You can also copy and modify an
existing file to create your own audience definition.

Appendix A explains the audience file syntax. Refer to Appendix B for
information about how to copy audience file information into a job file.
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Bit Rates in Audiences

Bit rates are stated in kilobits per second (Kbps). There are several parameters
that you must consider when creating an audience:

+ You need to know the channel capacity supported by the connection.

+ The maximum streaming bit rate is the highest bit rate that the bit-rate
smoother allows for audio or video transmission by a streaming server. The
maximum streaming bit rate must be less than the channel capacity.

« The combined media bit rate is the sum of the audio bit rate and the video
bit rate in a presentation.

» The audio bit rate is the specified bit rate for an audio stream.

Audience Considerations

28

You can adjust the job parameters and create specific audiences that take your
content and broadcast requirements into account.

Consider the following criteria when developing a job:
« The type of content
« The size and length of the presentation
+ The level of video quality you want
« The level of audio quality you want
» The available bit rate

» The amount of time required for encoding

SureStream Audiences for RealMedia Clips

When you choose to encode a clip for a particular audience, you are telling
Helix Mobile Producer to create a stream for that audience.

Note that although you can choose more than one audience for an encoding
job, the amount of encoding time required and the size of the encoded output
will increase with every audience stream that is added. For that reason,
generally it is recommended that you select no more than two or three
audiences that you know you need for a given clip.
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A job is a central aspect of encoding with Helix Mobile Producer.
The job defines how to encode your clip or broadcast. It selects the
media inputs, sets the encoding properties, and defines the
destinations, such as whether to export the encoded stream to a clip,

forward it to a server for broadcast, or both.

Working with Jobs

Each time you encode a clip or broadcast, Helix Mobile Producer creates a job
that records the encoding settings. You can export each job to a separate job
file, which is an XML formatted text file that you can manually edit as
described in Appendix B. Once you have exported a job file, you can import it
to apply the same settings to another clip or broadcast. Although using a job
file is optional, you’ll find job files highly effective if you encode a lot of clips
or broadcasts.

The Structure of aJob

Whether you use the graphical application or the command-line application,

you can export your job settings in a job file for later use. You can also modify
a job file’s settings, either through Helix Mobile Producer or by hand, to create
a new job quickly. The job file uses an XML-based format to define all of the

job’s encoding settings.

For More Information: For information about specifying jobs on
the command line. Appendix B explains the job file syntax.

Creating a New Job File

Whenever you encode a clip or broadcast, Helix Mobile Producer creates a job
automatically, letting you choose whether or not to export the job settings to a
file. You can also create a job file without actually encoding any streams. This
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allows you to define job profiles to use later. The following steps describe the
basic procedure for creating, editing, and saving a job file.

» To create a new job:

1. Start a new job file by choosing File>New Job or pressing Ctrl+N. Specify
the export type and the encoding properties (input type, output type,
audio/video tracks). A new, untitled job is created.

2. Define your encoding settings. You can set up your audiences, define clip
information, turn on video filters, create input and output file names, and
so forth.

3. You can export your job by choosing File>ExportJob. The job file is
automatically exported with the file extension .xml.

Warning! Give the job file a descriptive title that will help you
to remember the purpose of the job. For example, you might
name a job file GeneralVideoForDialUpModems.xml.

Note: You can share an exported job by giving the job file to
another Helix Mobile Producer user. If you defined inputs and
outputs, the user needs access to those same sources and
destinations to run the job.

Using and Modifying Existing Jobs

Once you have exported a job file, you can use it as the basis for other
encoding jobs. Suppose that a certain job file has all the basic settings you
want, but for a certain clip you also want to turn on the video noise reduction
filter. You just import the job file, turn on the noise reduction filter, and
encode the clip. When you’re done, you can discard the changes, or export the
job under a new job file.

Tip: Helix Mobile Producer supplies a number of predefined
job files that are stored in the defaults subdirectory under the
Helix Mobile Producer main directory. You can use these files
as templates for your own jobs, or create your own jobs from
scratch using the graphical user interface.

» To open and modify an existing job file:

1. To open a job, choose File>ImportJob (Ctrl+l) command and select the job
file.
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2. Make any necessary changes, which may include the following:

« If you defined inputs and outputs in the job file, Helix Mobile
Producer uses these same inputs and outputs. You can easily change
this by deleting the input and output names and defining new ones,
as described in “Setting Up Input and Output” on page 20.

» Double-check the audience settings for the job to ensure that you are
encoding the output properly. See “Setting Job Parameters” on
page 47 for more information.

« A job file can record specific clip information. You may need to add or
change this information each time you encode with an existing job

file.

3. When you finish making necessary changes, choose File>Export Job
(Ctrl+E) to export the changes to the existing job file. If you want to create
a new job file, enter a new file name.

Restoring the Active Job before Saving

To restore the active job, that is reset the settings stored on the disk, click
File>Revert or press Ctrl+R.
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BROADCAST

This chapter explains the different broadcast methods and describes

the different parameters for each broadcast method.

RTP Broadcast Mode

RTP (Real-time Transport Protocol) is a standards-based packet format
designed as the companion to the RTSP protocol. MPEG Players, for example,
use RTP as its packet format. Helix Server fully supports RTP, and shifts to
RTP automatically when streaming to an RTP-based client.

The following illustration shows the broadcast options that are available in
RTP mode. These options are described in the table following the illustration.

RTP options

¥ Bmadcast: IHTP ;I

Server dddress |1 27001

Part Fange: IEDED . 5054
TTL: |3

SDP file: [live. sdp Save .. |
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The following table lists and describes the broadcast options you can select

when using RTP broadcast mode.

Option

RTP Broadcast Options

Description

Server Address

A randomized IP address that is automatically created. You
can modify this address by entering the IP address for the
streaming server.

Port Range

The SDP file will pass this port to your server. The
destination will include the port you specified and three ports
above. For example, if you specify port 8558, the ports 8559,
8560, and 8561 will also be included. You must select an
available port range that is not in use. For an audio-only
broadcast, the actual port used is two ports higher than the
selected port. For example, if you select port 8558, port 8560
is used.

Note: Do not set your server to use these ports in the server
administration interface.

TTL stands for Time to Live. This is a value from 0 through
255 that defines the scope within which multicast data
packets should be sent over a network using IP as its protocol.
Each router decrements the TTL by 1. When the value for a
given data packet reaches a predefined lower limit, the router
throws the packet away. By default, TTL is set to 1.

SDP file

SDP stands for Session Description Protocol. The SDP file,
also known as the announce file, enables viewers to connect
to a live encoding session. This file contains information
about the audio and video streams in the live broadcast (for
example, the type and format of the media) and information
that players need to receive the media (for example, address
and port data). By default, an announce file is generated
automatically each time a live encoding session starts.

For more information about RTP, please read the following documentation:
« RTP— "RTP: A Transport Protocol for Real-Time Applications," RFC
1889, available at http://www.ietf.org/rfc/rfc1889.txt.

« RTP—"RTP Profile for Audio and Video Conferences with Minimal
Control," RFC 1890, available at http://www.ietf.org/rfc/rfc1890.txt.
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Tip on Firewall Configuration

Topology

Producer sever protocol

& 4 s

- -
RTSP/RTP ':ri':ﬂf “TSP"“TT
) protocol e pratocol
Private .
p 1P )
gg, Private Netwo!
K
Helix Mobile Firewall Streaming RTSF/RTP RTSP/RTP
protocol

Y &

Usually it is very troublesome to get the Helix Mobile Producer UDP signal to

go through the firewall to the streaming server for live broadcast.

» Asimple solution is to follow these steps:

1. Map a public IP address to the streaming server via the firewall, so that
the streaming server has two IP addresses, one public IP address and one
private IP address.

. Configure the firewall to open up 4 UDP ports for every single live stream
(for example, if you use the default port for the streaming server is 8558,
open UDP ports 8558-8561)

. Make sure the firewall does not block the ICMP signal. Helix Mobile
Producer needs this to communicate with the streaming server.

. Change the public IP address within the SDP file generated by Helix
Mobile Producer to the private IP address. On one hand, RTSP/RTP
player can only connect to the the streaming server via the private address,
but on the other hand, Helix Mobile Producer needs to know the public IP
address of the streaming server in order to send the live stream to it. So
modifying the SDP file by hand is the easiest way to do this.

After all these steps, you should be able to connect to the streaming server

using a handset within the protected private network.
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Helix Broadcast Mode

You can use a computer running Helix Server as the destination server for
your encoded output. On receiving your output media, Helix Server will
immediately broadcast the stream to your audience.

For the RealAudio/RealVideo export type, four methods (3 push methods and
one pull method) are available:

» Push broadcasting

In push broadcasting, Helix Mobile Producer initiates the broadcast
stream and delivers the stream to Helix Server when the broadcast begins.
There are several methods of push broadcasting:

« account-based, push broadcast—This is the simplest broadcasting
method to set up, requiring no configuration on Helix Server. Helix
Mobile Producer also receives statistical feedback from Helix Server.
See “Account-based Push Broadcast” on page 38.

- password-only, push broadcast—This is similar to account-based
broadcasting, but it is more efficient with bandwidth. It requires
server set-up and does not provide server feedback, however. See
“Password-Only Push Broadcast” on page 41.

« multicast push—This method is available if you have a multicast-
enabled network and you want to deliver the broadcast stream to
several servers. See “Push Multicast Broadcast” on page 42.

« Pull

In pull broadcasting, Helix Mobile Producer does not deliver the
broadcast stream as soon as you start encoding. Rather, it waits for Helix
Server to request the stream, which occurs when the first RealPlayer user
requests the broadcast.

The following illustration shows the broadcast options that are available in
Helix broadcast mode.
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The Broadcast Methods

[+ Broadcast

tethod: I Fush Account-Base VI

Server Mame;

Puzh Passward-Only
Puzh Multicazt

HTTF port;

Uzemame: I

Pazsword: I [~ Save password

Transport: = UDP ¢ TCP
Advanced Settings... |

Helix Mobile Producer provides several different broadcast methods that you
can use. Broadcasting methods break down into the two general areas of push
and pull:

Broadcast Transport Protocols

When you use a non-multicast, push broadcast method, you specify whether
to use TCP or UDP when delivering the broadcast stream to Helix Server. UDP
is the preferred protocol because of the lower network overhead. But you may
want to use TCP when delivering the broadcast over a lossy environment.

Note: The monitoring connection of an account-based
broadcast always uses TCP whether the data transport stream
is UDP or TCP.

- UDP

When Helix Mobile Producer uses the connectionless UDP protocol, it
does not receive notice that broadcast packets have arrived or are missing.
This generally reduces the network communications overhead and
improves the quality of the broadcast. Helix Server notifies Helix Mobile
Producer if it requires data to be resent. Thus, using UDP enhances the
performance of your broadcast.

A firewall between Helix Mobile Producer and Helix Server may block
UDP packets. The best solution is to configure the firewall to allow UDP
packets through the ports that Helix Mobile Producer and Helix Server
use the broadcast transmission. These ports, which vary depending on the
broadcast method, are described in the sections about setting up each type
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of broadcast. See “Advanced Settings - Account-Based Push” on page 39
and “Advanced Settings - Password-Only Push” on page 42.

- TCP

If you select the TCP protocol when broadcasting, Helix Mobile Producer
and Helix Server establish a two-way connection. If a broadcast packet is
lost in transmission, the network itself requests the packet to be resent.
This makes TCP a highly reliable protocol for broadcast on a network
prone to high packet loss. It is also more likely to pass through firewalls
that you cannot configure to accept UDP communications.

Using TCP incurs a higher network and machine overhead, however, and
can lead to inefficiencies. Helix Server does not need all stream packets to
keep a broadcast flowing to RealPlayer. If a packet is lost, the network
requests the packet again from Helix Mobile Producer. That packet may
no longer be available, however. Or, if it is available, it may arrive at Helix
Server too late to be useful. Hence, both Helix Mobile Producer and Helix
Server must handle some network requests that do not benefit the
broadcast.

Account-based Push Broadcast

The following illustration shows the account-based push options that are
available in Helix broadcast mode. These options are described in the table
following the illustration.

The Account-based Push Parameters

[+ Broadcast

Server Mame: I

HTTP part: IBD

Stream Mame: IIive.rm

[REREN I

Pazzmard: I [~ Save pazaword

Transpart: f« UDP  TCP
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Account-based Push Parameters

Default value

Description

Server Name

none

The Server name is the DNS or IP of the server
to broadcast to.

HTTP Port

80

The Helix Server port that Helix Mobile
Producer Live contacts when the broadcast
begins. Following this initial contact, Helix
Server and Helix Mobile Producer Live
negotiate which server port to use for the
actual encoded output. This needs to be the
same as the HTTP port configured on the
Helix Server.

Stream Name

live.rm

The broadcast stream name that will be
exposed through any servers that connect.

Username

The username. This parameter is optional.

Password

The password. This parameter is optional.

Save Password

unchecked

If checked, Helix Mobile Producer stores the
password in clear text in the job file, if the job
is subsequently saved.

Transport

UDP

The transport method for the broadcast. UDP
is the default, but TCP may be desireable for
more complex networks (such as broadcasting
over the internet to the server), or networks
that do not allow UDP traffic.

Server Name

Advanced Settings - Account-Based Push

none

The Server name is the DNS or IP of the server
to broadcast to.

The following illustration shows the account-based push advanced
parameters. The following table describes the advanced settings dialog for
Account based push.
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Account-Based Push Advanced Parameters

m Advanced Settings - Push Account-Base

[V i Accept UDP resend requests}

Listen Address: IAutomatic vI

[+ Enable TCF reconnect

Wit time between reconnect attempts;

Forward Eror Correction

Stream Redundancy: IEI i

Redundancy Offzet; IEI secondz
oK I

|3D zeconds

LCancel

Account-Based Push - Advanced Parameters

Parameter Default value Description

Accept UDP checked When UDP is selected as the transport method,

resent requests this setting determines whether or not resend
requests will be accepted from the server for lost
packets.

Listen Address Automatic | The listen address the encoder will listen for
connection on. For more information, see “Listen
Address Values” on page 41.

Enable TCP checked When enabled, and using the TCP transport

reconnects method, if the connection is ever lost to the server,
the encoder will attempt to resetablish it after the
specified wait time (below).

Wait time 30 seconds | The wait time between attempts to reconnect to

between the server when using TCP transport. In most

reconnect cases, 30 seconds is sufficient time for the server

attempts to do an automatic restart.

FEC Stream 0 The percentage of redundant packets the encoder

Redundancy sends to the server. This effectively sends out
duplicate packets, increasing the overall
bandwidth used for the broadcast.

Redundancy 0 If stream redundancy is set to 100%, this value

Offset determines the delay before sending the
redundant stream packets.
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Listen Address Values

The listen address sets the IP address that Helix Mobile Producer Live uses to
listen for packet resend requests from Helix Server. For the listen address, you
can use one of the following possible values:

« Automatic. This is the safest setting, and will work with most firewall
configurations.

« System IP (the IP address of the machine).
» System IP 2 (the second IP of the machine is multi-homed).
+ An IP address typed in by the user.

If your Helix Mobile Producer Live machine has multiple IP addresses, enter
the IP address that Helix Mobile Producer Live should use for
communications from Helix Server.

If you are broadcasting through a firewall performing network address
translation (NAT), set the listen address to the IP address of the firewall or the
value 0.0.0.0. The 0.0.0.0 value tells Helix Server to allow a Helix Mobile
Producer Live connection from any IP address. The connection still requires
the valid password, however.

Password-Only Push Broadcast

The following illustration shows the Push Password-Only options that are
available in Helix broadcast mode. These options are described in the table
following the illustration.

The Password-Only Push Parameters

[+ Broadcast

tethod:

Server Mame: I

Part Range:  |3020 - |a050

Stream Mame: IIive.rm

Pazzmward: I [~ Save pazzword

Transpart: f« UDP  TCP
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Password-Only Push Parameters

Parameter Default value Description

Server Name none The Server name is the DNS or IP of the server to
broadcast to (for example, server.real.com). See
the Broadcast Spec for detailed description.

Port Range 3020 - 3050 | The port range for streaming.

Stream Name live.rm The broadcast stream name that will be exposed
through any servers that connect.

Password - The server admin password.

Save Password unchecked | If checked, stores the password in clear text in the
job file, if the job is subsequently saved.

Transport UDP The transport method for the broadcast. UDP is
the default, but TCP may be desireable for more
complex networks (such as broadcasting over the
internet to the server), or networks that do not
allow UDP traffic.

Advanced Settings - Password-Only Push

Advanced parameters for Push Account-Based are the same as Push Account-

Based. See “Account-based Push Broadcast” on page 38.

Push Multicast Broadcast

The following illustration show.
in Helix broadcast mode. These
the illustration.

The Push Multicast Parameters

[+ Broadcast

b ethod:

Przh Mulbicast

s the multicast push options that are available
options are described in the table following

Multicast Address: I

Part Fange: |3IJ2D . ISDED

Streann Marme: IIive.rm

FPazzward:
TTL: |3
Tranzport: f+ UDFP " TCP

I [~ Save password
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Push Multicast Broadcast Parameters

Parameter Default value Description

Multicast none The multicast IP address.

Address

Port Range 3020-3050 | The port range for streaming.

Stream Name live.rm The broadcast stream name that will be exposed
through any servers that connect.

Password - The server admin password

Save Password unchecked | If checked, stores the password in clear text in the
job file, if the job is subsequently saved.

TTL 3 TTL stands for Time To Live. A value in the range
0 through 255 defines the scope within which
multicast packets should be sent over a network
using Internet Protocol (IP). Each router
decrements the TTL by one. When the value
reaches a predefined lower limit, the router throws
the packet away.

Transport UDP The transport method for the broadcast. UDP is

Advanced Settings - Push Multicast

the default, but TCP may be desireable for more
complex networks (such as broadcasting over the
internet to the server), or networks that do not
allow UDP traffic.

The following illustration shows the Push Account-Based advanced

parameters. The following table describes the advanced settings dialog for
Account based push.
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Push Multicast Advanced Parameters

dvanced Settings - Push Multicaskt

Metadata Resend Interval: IE seconds

Forward Eror Correction

Stream Redundancy: IEI k

Redundancy Offzet; IEI secondz

ok I LCancel

Push Multicast Advanced Parameters

Parameter Defaultvalue Description

Metadata resend |30 seconds | The frequency at which to send stream metadata

interval to servers connected to the Multicast. When a new
server connects to the multicast, it must receive
the header metadata before it can subsequently
provide the stream to clients.

FEC Stream 0 The percentage of redundant packets the encoder

Redundancy sends to the server. This effectively sends out
duplicate packets, increasing the overall
bandwidth used for the broadcast.

Redundancy 0 If stream redundancy is set to 100%, this value

Offset determines the delay before sending the
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The Pull Broadcast Parameters
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=

[+ Broadcast

fMethod: =
Ligten Address: |192.158.1|35.112
Ligter Part: |302D—
Stream Mame: IIive.lm

Server Pasaword: I

[~ Save password

Server Timeout; |3D seconds

Pull broadcast Parameters

Parameter Default value Description

Listen Address Automatic The listen address the encoder will listen for
connection on. For more information, refer to
“Listen Address Values” on page 41.

Listen Port 3031 The port the encoder will listen on for
connections.

Stream Name live.rm The broadcast stream name that will be exposed
through any servers that connect.

Server Password | none

Save Password unchecked | If checked, stores the password in clear text in the
job file, if the job is subsequently saved.

Server Timeout |30 The number of seconds Helix Mobile Producer
will wait for a ping from a connected Helix Server
before assuming no clients are connected to the
stream and closing the connection.

Note: There are no Advanced Settings for Pull broadcast.
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CHAPTER

8

SETTING ENCODING PARAMETERS

This chapter provides detailed descriptions of audio and video

encoding parameters and options.

Setting Job Parameters

When encoding a media, you can define job-specific parameters: you can
specify the track you want to encode (audio and/or), the bit rate control
(variable or constant bit rate) and the number of encoding passes.

Audio/video encoding

If the input source contains both audio and video tracks, you can indicate the
track you want to encode by selecting the corresponding option button, as
shown in the following illustration.

Controls for Selecting Tracks

| Audio/Video Streams IFiIters | E=port settings & Metadata

lah IBitHate /i (Enc:nde: ¥ audic v viden)

Bit rate control

Each audience is either constant bit rate (CBR) or variable bit rate (VBR). The
CBR audiences are designed for streaming. When you use them, you can
encode multiple audiences into a clip or broadcast. For example, a single clip
can stream to 56 Kbps modems and faster broadband connections when you
use CBR encoding.

The VBR audiences are designed for downloadable clips, but can also be used
for streaming in some instances. When you encode a downloadable clip, you
select a VBR template according to how highly you want to compress the
input, or how well you want to preserve the input’s quality. Unlike CBR clips
that can have multiple audiences, VBR clips can include just one audience.
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Constant bit rate (CBR)

Use this option if your content is going to be streamed over a limited-bit-rate
channel such as a network. If you select this parameter, the output stream is
delivered at the single, constant bit rate that you’ve specified.

Note: Selecting this setting might lower the quality of the
video output. For MPEG-4 encoding, some video frames might
be omitted to ensure that the output video stream conforms to
the CBR that you selected. Higher bit rate values reduce coding
artifacts, but they use more of the available bit rate.

When you create a clip, you can choose constant bit rate (CBR) or variable bit
rate (VBR) encoding. In Helix Mobile Producer, each audience template is
either CBR or VBR. CBR encoding is the more traditional method of encoding
streaming video. It maintains a consistent bit rate for the stream, such as a
constant 34 Kbps when streaming to 56 Kbps modems. You should generally
use CBR video when streaming at bandwidths below 350 Kbps, and anytime
you want to use a SureStream clip to encode multiple bandwidths into the
same clip or broadcast. At high bandwidths, however, you can use CBR or VBR
video.

Variable bit rate (VBR)

Use this option to set the variable bit rate, or average bit rate, for encoding the
video. This bit rate is expressed in kilobits per second (Kbps). By default, the
maximum bit rate is twice the average bit rate.

Variable bit rate encoding generally provides superior video quality to
constant bit rate encoding. It gives more bandwidth to scenes that are hard to
compress, making the most visible difference in videos that have fast moving,
high-action scenes. VBR is not compatible with SureStream technology,
however, so you can encode a VBR clip only for a single bandwidth. VBR
encoding is suited for bandwidths of 350 Kbps or higher.

Unlike a CBR clip, a VBR clip does not maintain a constant streaming rate.
Instead, it has a target average bit rate (or quality) and a maximum bit rate.
For example, Helix Mobile Producer’s 450 Kbps VBR download audience
averages 450 Kilobits of data per second. However, the audience has a
maximum of 900 Kbps, meaning that the stream can, if necessary, consume
up to 900 Kilobits of data a second. These data spikes typically occur during
high-action sequences, resulting in greater video clarity and higher frame rates
than CBR encoding.
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Tip: In Helix Mobile Producer, audience templates that use
VBR encoding include ‘VBR’ in the audience name. If the
template does not say ‘VBR,’ it is a CBR template.

For More Information: Two-pass encoding is an important
component for creating a high-quality VBR file. For more
information, refer to “Single pass/double pass encoding” on
page 52.

VBR Clips for Download

VBR clips are better suited for downloading than are CBR clips. Because a
viewer downloads the entire clip before playing it, the bandwidth spikes
inherent in a VBR clip will not cause playback problems. As you encode clips
for download, you can consider the VBR encoding speeds as a guide to quality
and file size. For example, a 450 Kbps VBR download will generally have lower
quality and a smaller file size than a 750 Kbps VBR download.

Tip: Quality depends on the source content. For a video that
has relatively little action and small dimensions, for example,
750 Kbps VBR encoding may offer little improvement over 450
Kbps VBR encoding.

VBR Clips for Streaming and Broadcasting

Although VBR audience templates are geared for video downloads, you can
also use VBR encoding for streaming clips and broadcasting live events. The
primary reason to do this is that VBR offers better quality than CBR. For
example, depending on the content, a 350 Kbps VBR stream may have roughly
the same visual quality as a CBR stream encoded at 450 Kbps.

To benefit from VBR, the streaming network must be able to accommodate
bandwidth spikes. Local area networks (LANs) and cable modem users are
good candidates for VBR streaming. Because all viewers in these networks
share a large pool of bandwidth, a VBR clip’s intermittent bandwidth spikes
tend not to overload a single viewer’s connection bandwidth. Connections in
which bandwidth is not shared, such as DSL, can prove problematic. A 450
Kbps VBR clip has a maximum bandwidth of 900 Kbps, for instance. If a DSL
connection has a maximum throughput of 500 Kbps, the VBR clip may stall.

When you stream a prerecorded VBR clip on demand, each viewer generally
starts playback at a different time. This means that the bandwidth spikes
inherent in the clip are spread out over time for all viewers. When you
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broadcast a VBR stream, however, bandwidth spikes occur for each viewer at
the same time. When broadcasting, therefore, your network needs to handle
higher cumulative spikes than when you stream prerecorded clips.

Note: Streaming a VBR clip requires that you use Helix Server
version 9 or higher.

Tip: Multicasting, which is available on some intranets, helps
to overcome the bandwidth spikes of standard unicasting by
delivering one stream to all viewers, rather than a separate
stream to each viewer. For more information, refer to the
multicasting chapter of Helix Server Administration Guide.

VBR Encoding Settings

For each VBR audience template, three settings affect how the clip or
broadcast is encoded: maximum bit rate, average bit rate, and quality. Each
VBR clip uses these two settings to determine how it encodes its data. To
create a VBR clip appropriate for your needs, it’s important to understand
how these settings interact.

Average Bit Rate

A VBR clip’s average bit rate value reflects the average bandwidth of the clip
measured as the total number of Kilobits consumed divided by the timeline in
seconds. The actual bandwidth at any point during clip playback may be lower
or higher than this value. Through most of the video, however, the second-by-
second bandwidth use will be close to this value.

Maximum Bit Rate

A VBR clip’s maximum bit rate caps the bandwidth that the clip can consume.
It is typically set by default to twice the average bit rate. A 450 Kbps VBR clip
has a maximum bandwidth of 900 Kbps, for example. So during a high-action
scene, for example, a video encoded with this audience may have a bandwidth
spike of up to 900 Kbps. These spikes are only occasional, however, and the
overall clip playback rate stays close to the average bit rate.

Although you can set the maximum bit rate value higher or lower, a higher
setting is unlikely to result in significantly greater quality. You can lower the
setting if you want to reduce the bandwidth spikes on your network. Keep in
mind, however, that lowering this maximum decreases the benefit of VBR
encoding. The closer the maximum bit rate value approaches the average bit
rate value, the more the clip behaves like a CBR clip.
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Tip: Keep the maximum bit rate value between 50 percent to
100 percent greater than the average bit rate setting. For a 450
Kbps template, for example, the maximum rate should be 675
to 900 Kbps.

The leaky bucket algorithm

Both CBR and VBR are consistent with the “leaky bucket” concept. Leaky
bucket is a flow-control mechanism designed to reduce the effect of the
inevitable variability in input data streams as they are “injected” into
communication networks. The leaky bucket algorithm performs the following
functions:

« It controls what the encoder can inject into the network.

« It prevents the data “bucket” from overflowing by automatically
regulating the bit rates in the event that the encoder generates too much
data or very complex data.

« It prevents “burstiness” in the input stream, ensuring a smooth, even data
flow.

The Leaky Bucket Algorithm

Faucet
— O «— Packet
O
O— Unregulated flow
0
Leaky bucket —, | _@ 0

Interface with Packets hold
b leaky bucket ™ % < by the bucket

O
0 «— Constant flow
O

Water drips out of the
bucket at a constant rate

L

Network

The video buffer is the normative MPEG-4 video buffering verifier (VBV). The
VBV is the instantaneous bit-rate smoother, or transmission buffer, that
ensures that the instantaneous bit rate never exceeds the target bit rate behind
the video buffer. You can also use it as a reception buffer.
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Single pass/double pass encoding

Although it is specified at the Job level of the encoder, 2-pass encoding is
specific to the video codecs.

For offline encoding only, you can select either the single pass or double pass
encoding, by selecting the Enable double pass radio button. Double-pass
encoding is for offline encoding with Helix Mobile Producer. It uses
information from the first pass to reallocate the bits during the second pass.
This enables you to encode video input at a very high level of quality. Keep in
mind though, that double-pass encoding takes twice as long as single-pass
encoding.

Note: This setting is ignored for live encoding.

Two-Pass Encoding

With two-pass encoding, which is used only when encoding from a digitized
source file, Helix Mobile Producer runs through the entire source video once
to gather information about how best to encode the streaming clip. It then
makes a second pass to encode the streams. Two-pass encoding can
substantially increase clip quality, but it requires more encoding time. The
first pass takes about as long as it would to encode the source file for one
target audience.

Although two-pass encoding helps when you use constant bit rate encoding, it
provides greater benefit for variable bit rate (VBR) encoding, described in
“Variable bit rate (VBR)” on page 48. With two-pass encoding, Helix Mobile
Producer can analyze the entire video file to determine how best to vary the
playback bit rate through the length of the clip. Without two-pass encoding,
Helix Mobile Producer sequentially analyzes small sections of the source file
during encoding, creating a string of VBR sections within the clip.

Tip: Use two-pass encoding whenever you encode from a
digitized file. Turn it off only if you must decrease the
encoding time.

Setting the Bit Rate
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Use this option to set the standard bit rate for encoding the video stream, in
kilobits per second (Kbps). Note that to set a constant bit rate or a variable
(average) bit rate for the clip, you use the Bit rate control option, as described
in “Bit rate control” on page 47.
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Setting Audio Parameters

This section explains how to use the various encoding options to set the basic
parameters for encoding audio input.

The default audio encoding parameters in Helix Mobile Producer have been
set carefully to provide the best overall quality of audio output for the most
common streaming audio scenarios. We recommend changing these
parameters only if you have advanced knowledge of audio encoding.

The Audio Parameters (AAC encoder)

#udio Codec: [ 2aC =l

Bit rate: I 2000 "I bpz

[ Use joint stereo

[ Custom Sampling B ate

Channel mode: Imana vI
Sampling rate: IB.DDD vI kHz

Encoder type

The following table lists and describes the six audio encoding formats
supported by Helix Mobile Producer.

Audio Encoding Formats

Format Description

AAC Advanced Audio Coding Low complexity. AAC-LC allows the
following settings:

* bit rate - a value from 8 000 to 320 000 bps, default value is
96 000 bps

* joint stereo option

* the audio sampling rate in kHz - allowed range is
dependant of the defined audio bit rate

¢ the number of channels (1 or 2) - allowed range is
dependant of the defined audio bit rate

AAC Plus AAC Plus allows the same settings as AAC-LC, except joint

stereo option.

Note: AAC Plus is only available for use with the 3GPP v6
export types.
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Audio Encoding Formats (continued)

Format Description

Enhanced AAC Plus | Enhanced AAC Plus allows the same settings as AAC-LC,
except joint stereo option.

Note: AAC Plus is only available for use with the 3GPP v6
export types.

AMR narrowband Adaptive multirate speech codec. The options for AMR-NB
are limited to the bit rate selection, and the Use Silence
Detection option.

AMR wideband Adaptive multirate speech codec. The options for AMR-WB
are limited to the bit rate selection, and the Use Silence
Detection option.

QCELP QualComm Code Excited Linear Predictive Coding speech
codec. The only option is one of these two bit rates:

* 14 000 bps (full-rate)
* 6800 bps (half-rate)

RealAudio RealNetworks audio file format. The only option is the codec
flavor.

MP3 MPEG-3 audio file format. The only option is the bit rate (in
bps).

Note: Stereo or Mono is specified automatically: bit rates
below 64 000 are mono, 80 000 and above are stereo. If
the input is mono, then the output is also mono.

Make-up of the Enhanced AAC Plus codec

Parametric

AAC-LC SBR Stereo

aacPlus
(= MPEG-4 High Efficiency AAC)

Enhanced aacPlus
{= MPEG-4 High Efficiency AAC + MPEG-4 Paramelric Steraa)

Bit rate

Use this option to specify the bit-rate value for an audio stream in bits per
second (bps). Different bit-rate ranges are available for different audio
encoders.
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Note: This option is not available for the RealAudio encoder.

Use joint stereo (AAC audio encoder only)

Joint stereo coding removes redundancies between the left and right audio
channels of stereo sources. Select this option to encode channel redundancies
and differences separately. Using this setting can reduce the bit rate by as
much as half, but it also might introduce some artifacts. Clear the Use joint
stereo check box if you want the redundant portions to be encoded twice.

Custom Sampling Rate (AAC, AAC Plus and Enhanced AAC Plus encoders)

When you check this option, you can specify the channel mode (mono or
stereo), and the sampling rate.

Silence Detection - DTX compression (AMR encoder only)

This option enables the encoder to detect silence periods in speech. Such
p p p

periods are then coded with a "silence targeted algorithm" that improves

coding efficiency and decreases the bitrate.

Flavor (RealAudio encoder only)
Select an encoding preset depending on the input audio stream (voice,
music,...).
Setting Video Parameters

This section explains how to use the various encoding options to set the

parameters for encoding video input. The following illustration shows the
video parameters in the Audio/Video Streams tab.
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The Video parameters (H.264 video encoder)

Video Codec: I H.264 A I

Bit rate: 37.8 kbps [Target - Audio]

Wideo codec level: I Automatic ;I

b an keyframe distance: IEDDD i’ "J— millizeconds
Change frame rate; |1D ;I fpz

Encoding complesity: I High ;I

Wideo mode: I Marmal Mation Video ;I

Encoder type

The following table lists and describes the three video encoding formats that
Helix Mobile Producer supports.

Video Encoding Formats

Format Description

MPEG-4 ISO/IEC video codec

H.264 MPEG-4 AVC. International Telecommunications Union video codec
H.263 International Telecommunications Union video codec

RealVideo RealNetworks video codec

RealVideo Codecs

RealVideo 10 is the default RealVideo codec used with Helix Mobile Producer,
but you can also encode with older RealVideo codecs. RealNetworks
recommends using RealVideo 10 unless you need faster encoding performance
during broadcasts, or you need to stream video to RealPlayer 8.

RealVideo 10 Codec

The RealVideo 10 codec creates the highest quality compressed video possible.
It offers improved visual quality over RealVideo 9 and RealVideo 8, especially
with fast-action scenes and on-screen text. Because RealVideo 10 performs
more complex analysis of video data than earlier codecs, encoding may take
more than twice the time required with RealVideo 9. To help shorten the
encoding time and improve the quality of live broadcasts, Helix Mobile
Producer provides the following features:
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» RealVideo 10 is optimized for multiprocessor machines. Helix Mobile
Producer uses a second processor when the video height is greater than
180 pixels. When you encode a SureStream CBR clip for multiple
audiences, Helix Mobile Producer uses up to two processors for each
audience. For example, encoding a RealVideo clip for a 56 Kbps modem
audience and a 256 Kbps broadband audience can utilize up to four
processors.

When encoding pre-recorded clips, you can lower the codec complexity
level. This reduces the clip's visual quality, but decreases the encoding
time.

« For live broadcasts, Helix Mobile Producer uses automatic load
management features to compensate for the increased encoding demands
of RealVideo 10. This helps to ensure that Helix Mobile Producer does not
fall behind the video input rate. See "Broadcast Load Management".

RealVideo 10 is compatible with RealOne Player and later. Users of older
RealPlayers are prompted to update to RealPlayer 10 when they attempt to
play RealVideo 10 content. Playback of RealVideo 10 content consumes the
same amount of system resources on the viewer's computer as playback of
RealVideo 9. Viewers, therefore, will not notice any performance slowdown
when playing a RealVideo 10 clip compared to a RealVideo 9 clip.

RealVideo 9 Codec

RealVideo 9 improves on RealVideo 8 with higher compression and improved
visual quality. RealOne Player and later can play RealVideo 9 clips. Users who
have older versions of RealPlayer are prompted to autoupdate to RealPlayer 10
when the viewer attempts to play a RealVideo 9 clip.

RealVideo 8 Codec

The RealVideo 8 codec is backwards-compatible to RealPlayer 8. The video
quality is not as high as with RealVideo 9 and 10, but encoding is faster.
Additionally, RealVideo 8 requires fewer resources on the RealPlayer machine

to decompress. This makes it suitable for the slower processors of mobile,
handheld devices.

Bit rate is a value in bps that must be at least 8 kbps. The value is calculated by
taking the Total bit rate of the audience, and subtracting the audio bit rate.
The remainder is the video bit rate for the audience.
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Max key frame distance

This value defines the keyframe interval in seconds with accuracy to 1 decimal
place and a range of 0 to 30 seconds.

It is called Maximum time between key frames because it only defines an
upper-limit. Key frames may be inserted more frequently due to scene changes
or for other reasons. This value guarantees that there will be at least 1 key
frame every x seconds, where x is the user-specified value.

If 0 is specified, every frame encoded will be a keyframe, which will drastically
reduce the frame rate

The settings in this section are common to all video codecs.

Video Mode and Encoding Complexity are 2 parameters that come from
RealVideo encoders that will be applied to all the video codecs. Note that for
RealMedia encoding, the definition is more precise.

Change Frame Rate

Frame rate is specified on a per-audience basis for the video stream (this allows
different video streams in a multi-rate file to have different frame rates). The
value is specified in frames per second, with an accuracy of 1 decimal place.
(example: 30 fps, or 7.5 fps)

The acceptable range is 0.5 up to 30 frames per second (0.5 would represent
one frame ever two seconds).

Maximum Frame Rate

In multi-rate files, each video stream can have it's own frame rate setting.
There is no guarantee that the target frame rate will be achieved. Limiting
factors will include the frame rate of the source, the bit rate of the video
stream, the dimensions of the video stream, the codec used, and the load on
the machine.

RealVideo codecs should be feed all video frames, along with the target frame
rate to allow the codec to decide how to achieve the best results. For example,
if the target frame rate is 15 fps, but the bit rate and frame size make achieving
this consistently impossible, the RealVideo codecs will drop down to a lower
constant frame rate for the best end user experience.

Select this option to change the frame rate (the number of frames per second,
or fps) in the original video source. Note that reducing the frame rate
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decreases the bandwidth used by the encoder and might affect the minimum
bit rate.

Be aware that reducing the frame rate diminishes the quality of the motion in
the video stream and that it’s not necessary to do this for most video sources.

Encoding Complexity

Encoding complexity determines the amount of processing the codec will do;
more processing results in higher quality, but is also slower. When doing a
high bit rate live encode, it may be desirable to set a lower complexity level that
the system has the resources to maintain throughout the encode.

Encoding complexity

Encoding complexity level Description

High Default level and best quality. Also slowest. (2x or more the
processing resources of Medium)
Medium Balance between quality and complexity. (2x or more the
processing resources of Low)
Low Fastest encoding, but lowest quality.
Video Mode

Video mode helps the codec determine how to spend bits. The choices are
defined in the table below:

Video mode

Video Mode Setting Description

Normal Motion Video | Default: Suitable setting for almost all video content.
Provides a balance between framerate and image sharpness.

Sharpest Image Provides the sharpest quality image at the expense of
smoothness of motion and framerate

Smoothest Motion Provides the smoothest motion/highest framerates at the
expense of image clarity

Slide Show The absolute sharpest quality, displays video in a slide
show mode with very low framerates.

This encoder will always perform CBR encoding even if VBR is chosen at the
job level. Advanced settings for the H.264 codec are documented in the
following subsections.
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Setting Audio and Video Filters

This section describes the various audio and video filters included in Helix
Mobile Producer. You can use these filters (shown in the following
illustration) to adjust and customize your streaming video content in a
number of different ways before you begin encoding it.

The Filters Tab

Input/Output |Aud\oN\deo Streams | Filters IExpo[t settings & Metadata |

Audio fiters
Gan [0 2 0d8—— }—— o CharnelBaknee: [0 S L~ b A
Wideo filters
[~ Cropping I~ Deintedace [~ Brightness/Contrast Adjustrment
Left [0 = Te: [0 = ™ Inverse telecine Brightness m e ‘Jf
widy 320 = Heicht 200 3 ) i (€ & Evn arise [T
[~ PResize " Insertlogo [~ Gamma conection
[Costom o] | Braysse.. | ¥ | Link colors
widh 20 = Heht [20 3 Lt [0 F Top: [0 = il A————
I~ baintain aspect ratio B 1 el m -—J—
. 5 Aol B e——fi—

Audio Filters

Channel Balance

Use the slider to adjust the left/right balance for stereo audio inputs (from -
100 to +100). Negative settings skew the balance towards the left channel,
positive values skew it towards the right channel. A setting of 0 has no effect.

Note: This filter is only effective when both the input source
audio and the output codec are stereo.

Gain
Use the slider to set the volume level of the source audio before encoding.

The allowed range for the gain parameter is in decibels between -20 dB to
40 dB. When set to 0, this filter does nothing.
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Video Filters

Video prefilters are applied in a specific order in the encoding chain from first
to last as follows:

« Inverse Telecine

« Cropping

« Deinterlace

« Brightness/Contrast
« Gamma Correction
« Resize

« Logo Insertion

» Change Frame Rate

Inverse Telecine

Telecine is the conversion of film content (24 fps) into NTSC broadcast
format (29.97 fps). This video prefilter converts NTSC (29.97 fps) telecined
content back to the original film format (24 fps). Artifacts created by the
"telecine" process are removed. A mandatory parameter is needed to decide
the field priority of the input content (odd/even).

The Inverse Telecine portion is designed to take 29.97 fps input that
originated from 24 fps film and convert it back to 24 fps.

Note: This filter will only work with 29.97 fps source material.
If the original content was not telecined, the quality of the
output will be poor.

The Field Dominance parameter specifies the field order (either odd or even). If
the wrong field order is specified, the resulting video will be noticeably
distorted.
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Inverse Telecine Diagram

Telecine Inverse Telecine
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Cropping

This video prefilter crops the video to a specified region.

The video cropping prefilter exposes values for Left, Top, Width, and Height
for the cropping region. The basic restrictions on possible values are that the
cropped image must be no less than 32x32 pixels (or in the case of H.263,
128x96) and no larger than the original image.

Note: RealVideo codecs require their input video size to be
divisible by 4.

Deinterlace

This filter will remove interlace artifacts (jaggies) that are visible when
converting 29.97 fps - 60 fields/second interlaced video (this is what is
broadcast to your television) to 29.97 fps progressive video (what you see on a
computer screen). The jaggies that result from this conversion are a result of
the even/odd fields in the source video, and is most noticeable on moving
images.

Use this filter for video input that is interlaced. Keep in mind, however, that if
the original video source was not interlaced and you use the deinterlace filter
anyway, the quality of the output will be very poor.

Note: A video is interlaced if you can see a "combing" effect in
the preview panel. Essentially, an interlaced frame consists of
two images captured at different times and combined in one
frame in such a way that the two instants merge into a single
image.
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Deinterlace filter applied on an interlaced video (detail)

Jaggedness in an Jaggedness Removed
Interlaced Video with the De-interlace Filter

Color Adjustment
This video prefilter adjusts the brightness and/or contrast of the input video.

Both brightness and contrast have a value range of between -100 to +100 in
whole digit increments. A value of 0 has no effect. For the brightness filter, a
value of -100 equals full black, and +100 equals full white.

Brightness, contrast. You can adjust the brightness and contrast of a video
stream by dragging the sliders back and forth or by entering numeric values in
the corresponding text boxes.

Gamma correction. You can adjust the gamma values of the input video by
moving the sliders for the three colors components (R, G, B) individually (the
default method). Alternatively, you can select the Link colors option to link the
three sliders so that they move together, to increase or decrease full color
saturation.

Each component has a value range of between -100 to +100. A value of 0 has
no effect.

Resize

This video prefilter resizes the video to a specified width and height value. The
possible range of values for these parameters varies by the video codec, as
detailed in the table below.

Resizing Values

Min.
Codec Min. Size Max Size increment
H.263 (Only CIF, QCIF, and SQCIF | 128x96 (SQCIF) | 384x288 (CIF) -
are supported.)
H.264 32x32 640x288 4
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Resizing Values

Min.
Codec Min. Size Max Size increment
MPEG4 32x32 640x288 4
RealVideo 32x32 2048x2048 4

You can resize your video input either by selecting a predefined size (for
example, 50% or CIF) or by specifying the height and width of the video
output (in pixels).

Insert Logo

Use this option to add a still image logo overlay onto the video input frames
before encoding. A common use case is to insert a station or content provider
identifier.

The logo insertion filter has three parameters.

« The first is a filename and path to an image file. JPEG, BMP, PNG, and
GIF are the supported image formats; animated GIFs are not supported.

« The distance of the left edge of the logo from the left edge of the video.
» The distance of the top edge of the logo from the top edge of the video.

Change Frame Rate

Sets the maximum output frame rate of a video stream. In multi-rate files,
each video stream can have it's own frame rate setting. There is no guarantee
that the target frame rate will be achieved. Limiting factors will include the
frame rate of the source, the bit rate of the video stream, the dimensions of the
video stream, the codec used, and the load on the machine.

RealVideo codecs should be feed all video frames, along with the target frame
rate to allow the codec to decide how to achieve the best results. For example,
if the target frame rate is 15 fps, but the bit rate and frame size make achieving
this consistently impossible, the RealVideo codecs will drop down to a lower
constant frame rate for the best end user experience.

Select this option to change the frame rate (the number of frames per second,
or fps) in the original video source and specify the ratio for dividing frames.
Note that reducing the frame rate decreases the bandwidth used by the
encoder and might affect the minimum bit rate.

When changing the frame rate, you can specify a frame-rate divide ratio (either
2:1, 3:1, 4:1, or 5:1) or a target frame rate (from 1 through 30 fps). If you do
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change the rate, we recommend using 2:1, which is the default divide ratio. For
example, if your original video source has a frame rate of 30 fps and you use
the 2:1 divide ratio, the frame rate in the output will be1S5 fps.

Be aware that reducing the frame rate diminishes the quality of the motion in
the video stream and that it’s not necessary to do this for most video sources.

Setting Export Parameters

The following subsections describe the available export options and provide
detailed instructions on how to use them, as well as providing ancillary
information that will help you prepare your video and audio clips for
exporting.

These export options are shown in the following illustration.

The Export Parameters (3GPP v5 export type)

Input AOutput I AudioNideo Streams I Filters | Export Settings & Metadata |
Export Settings
Options to basic profile:
¥ Progressive-download profile

¥ Streaming-server profile linclude hint tracks)

Masimum packet size: |1iEE 3: bytes

Note: If you modify the export type, by default both options
will be selected.

If no option is selected, the media file will be downloaded and played locally
but not streamed from a server. Note that you will have to wait for the
complete file download before playing it.

Streaming-server profile (MPEG-4 and H.263 encoders only)

If you plan to stream video or audio content from a streaming server, you can
use the Streaming-server profile option to include "hint tracks" that tell the
server how to send the streams and what to set as the maximum bit rate for
the presentation.

Be aware that the addition of data such as hint tracks and headers to audio or
video streams during the encoding process results in the encoded files being
somewhat larger than the sum of the encoded media bit rates multiplied by
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the duration of the file ((audio bit rate + video bit rate) x duration). This does
not affect the bit rate or quality of the media, because this additional data
remains on the server and does not get streamed to the client.

Note: The hint track is required by the streaming server to
optimize the streaming experience. A 3GPP media file must
have a hint track in order to be properly streamed from most
streaming servers. The hint track is not required if the media
file is to be downloaded and played locally and not streamed
from a server. To avoid having Helix Mobile Producer add a
hint track to such a file, select the Basic-profile check box on
the Export tab before encoding the audio or video clip.

Progressive-download profile (MPEG-4 and H.263 encoders only)

By default, MPEG-4 files are generated with the metadata following the raw
media data, which results in efficient writing of the MPEG-4 files. However,
this means that a player must completely download an MPEG-4 file before
playing it, as the player cannot begin playback until it has received the
metadata.

If you have selected the Progressive-download profile option, the MPEG-4 file
is reordered at the end of the encoding process so that the metadata appears
at the beginning of the file. This enables a player to download and play the
content at the same time, rather than having to wait for the entire file to be
downloaded before playing it.

Maximum Packet Size (3GPP, MPEG-4 and RealMedia export types only)

The maximum packet size should be less than the maximum transmission
unit (MTU) of the network over which the content will be streamed. Packet
header "overhead" should also be taken into account in this calculation. By
default, the maximum packet size is configured to be appropriate for general
Internet usage, for which the MTU of 1,500 bytes takes into account UDP and
IP packet headers. For other types of target networks, such as ATM or wireless
networks, the maximum packet size should be adjusted to reflect the
corresponding larger or smaller MTU.

A maximum packet size that is too small will add unnecessarily high overhead,
as the packet headers will take a larger proportion of the bit rate relative to the
packet payloads.
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A maximum packet size that is too large will reduce the error resiliency of the
stream because the packets will be fragmented on the network, meaning that
the loss of one packet fragment will cause the entire packet to be discarded.

Calculating Maximum Packet Size
Use the following procedure to determine the maximum packet size that you
can use for a presentation that will be streamed over a network.

» To define the output packet size:

1. Identify the MTU for your network.
2. Identify the packet structure used on your network.

3. Subtract the header size from the MTU to get the number of bytes
available for the RTP packet, as shown in the following text and tables.
RTP streaming over UDP over Ethernet

The MTU is 1,500, and the packet structure is as follows:

Packet Structure

20 byte 8 byte 12 byte N byte
IP header | UDP header | RTP header | RTP payload

Use the following equation to determine the value to set for maximum
packet size over UDP packet size:

1,500 - 20 - 8 = 1,472
RTP streaming over RTSP interleave over Ethernet

The MTU is 1,500, and the packet structure is as follows:

Packet Structure

20 byte 28 byte 4itr)1¥§l-e§\1-sp 12 byte N byte
IP header | TCP header header RTP header | RTP payload

Use the following equation to determine the value to set for maximum
packet size over RTSP interleave:

1,500 - 20 - 28 - 4 = 1,448
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The following table lists the types of packet headers and the typical size
for each one.

Typical Packet Header Sizes

Header Size (in bytes)
1P 20
PPPoE 8
RTP 12
RTSP interleave |4
TCP 28
UDP 8

The following table lists the applicable RFCs and gives a description and
the typical MTU for each one.

Typical MTUs

RFC Description MTU
894 Minimally required 68
1051 ARCNet 508
1356 X.25,ISDN 576
1055 Serial line IP (SLIP) 1,066
1042, 2516 |IEEE 802.3 / 802.2, PPPoE 1,492
894, 895 Ethernet 1,500
1390 FDDI 4,352
1042 4-Mb token ring 4,464
1042 802.4 token bus 8,166
None 16-Mb token ring 17,914
1374 HIPPI 65,535

Loss Protection (RealVideo encoder only)

Adds error correction information to the video stream to assist the player in
reconstructing lost packets.

Latency mode (RealMedia export type only)

Each RealVideo clip has a maximum startup latency that determines how long
video requires to display after RealPlayer begins to receive the stream.
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There are three possible values:
» Normal (longest delay from real-time, but best viewing experience),

+ Moderate (shorter initial delay that may increase and produce some re-

buffering,
« Low (shortest delay, but intermittent sections of media may be lost).

If you select Normal, you can specify the maximum latency. This specifies the
video buffer size, from 1000 ms to 25000 ms. The default is 4000 ms.

Increasing the latency may be particularly useful for videos that stream at low
bit rates and start out with high action sequences. The longer latency creates a
larger data buffer for the starting sequence, and generally improves the video’s
appearance. Bear in mind, however, that a long latency time may cause restless
viewers to stop the presentation before it begins playback.

Note: The startup latency does not affect how quickly a
downloaded clip begins to play. Increasing the latency value,
however, can improve the visual quality in downloaded clips that
begin with fast-action sequences.

Setting Metadata

Helix Mobile Producer can encode clip information directly into a clip or
broadcast. This is highly recommended for all jobs because the clip
information tells the viewer about the stream and can help search engines
categorize clip.

You can specify the following information.

Title
In this field, enter the title of the clip or broadcast. Because this title appears
in the RealPlayer interface, it is best to use a short title.
Author
This field holds the name of the person or organization that created the clip.
Copyright

Here, enter the copyright string, such as (c) 2004 ABC Corporation.
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Keywords

The keywords field holds words that certain audio and video search engines
can read to categorize the clip. Add a few words that will help your audience
search for your clip. Separate each term with spaces. Unless you are adding a
proper name, use lowercase for each term. Avoid overly generic terms such as
video or music.

Description

This field holds a description of the clip that appears when the viewer displays
extended clip information. This allows you to describe the clip in detail
without creating a long title.

Rating (3GPPv6 and RealMedia export types only)

Selecting a rating in the pull-down list is highly recommended for any content
not intended for all age groups. The rating depends on the selected rating
system.

Note: 3GPP v6 accepts any two 4-char codes, plus a description.
Some predefined values are included, but other values can also
be entered.
MPAA (Motion Picture Association of America).
The current MPAA movie ratings consist of:

+ G - General Audiences: All ages admitted.

« PG - Parental Guidance Suggested: Some material may not be suitable for
children.

« PG-13 - Parents Strongly cautioned: Some material may be inappropriate
for children under 13.

« R - Restricted: Under 17 requires accompanying parent or adult guardian.

« NC-17 - No one 17 and under admitted.

BBFC (British Board of Film Classification)
The current MPAA movie ratings consist of:

« U - Universal: Suitable for all
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« PG - Parental Guidance: All ages admitted, but parents are advised that
certain scenes may be unsuitable for small children

+ 12 - Suitable for those aged 12 and over (video only)
+ 15 - Suitable for those aged 15 and over
+ 18 - Suitable for those aged 18 and over

+ R18 - Restricted 18: Suitable for those aged 18 and over and only available
at licensed cinemas and shops

OFLC (Australian Office of Film and Literature Classification)
The OFLC uses the following rating system:
+ G - Suitable for all viewers.
+ PG - Parental Guidance recommended for children under 15 years of age.
« M - Mature, recommended for audiences 15 years and over.

+ MA - Mature Accompanied. This category is legally restricted in that
children under 15 cannot see "MA" films or rent them on video unless
accompanied by a parent or adult guardian.

« R - Restricted. This category is legally restricted to adults. No one under
18 may view these movies in a cinema or rent them on videocassette.

« X - Restricted. This rating applies to sexually explicit material which is
restricted to viewers 18 years of age and over.

RealMedia
For RealMedia, the rating can be one the following:
« Not rated
- All Ages
+ Older Children
« Younger Teens
« Older Teens (15 years and over)
+ Adult Supervision Recommended

+ Adults Only
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Setting Preferences

This section explains how to use the options in the Preferences dialog box
(shown in the following illustration). To access this dialog box, click
Edit>Preferences in the menu bar at the top of the Helix Mobile Producer
workspace.

The Preferences Dialog Box

Realtdedia Temporan Directon

£~ Custom: Browse. .

f+ Same as input file

Drefault Batch Output Directorg

£ Custom: Browse. .

¥ Respect job-defined input filez when adding jobs to the Batch list

0K LCancel |
A

Preference Options

The following paragraphs discuss the options that enable you to set the
default Realmedia temporary directory, and the default batch output
directory.

Temporary Directory

By the default, the temporary directory is the same as the output file directory,
but you can specify a custom directory.

Default Batch Output Directory

By the default, the batch output directory is the same as the input file
directory, but you can specify a custom directory.

Respect Job-Defined Input Files...

If you uncheck this option, the input file defined in the job will be ignored.
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CHAPTER

USING THE COMMAND-LINE ENCODER

This chapter shows you how to run Helix Mobile Producer from the command
line in Windows. Helix Mobile Producer gives you the ability to encode
streaming audio or video presentations as files or encodes live capture input
for live broadcasts and file output.

Basic Encoding

Helix Mobile Producer provide a simple command-line interface you can use
to encode your audio or video input.

Getting Started
You access the command line from the Windows command prompt.
» To use the command-line interface:
1. Open the Command Prompt window.

2. Set the current directory to match the location of the hmprod.exe
program by typing cd followed by the path to the program.

Command Prompt

Microsoft Windows 2888 [Uersion H.8B.21951
¢G> Copyright 1985-2088 Microsoft Corp.

D:%»cd Program Files“Helix“Helix Mohile Producer 11.8%

D:“Program Files“Helix“Helix Mohile Producer 11.8>_

3. Type hmprod followed by command-line arguments to start the
command-line encoder.

Note: Starting the command-line encoder without including
any arguments will display the syntax and command-line flags
for the application you have specified (hmprod.exe, in this
case).
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> To set the path to Helix Mobile Producer:

To avoid navigating to the directory that contains Helix Mobile Producer,
include the path to the executable (.exe) file in your Path variable. For
example, enter the following command at the command prompt:

set PATH=%PATH%;D:\Program Files\Helix\Helix Mobile Producer;

Basic Encoding Commands

You can use the command-line interface to encode streaming media in one of
two ways: offline (file input to file output) or live (live capture input to file
output or broadcast output).

To run a job file from the command line, use the following syntax:
hmprod -j <job_file> [input] [destination] [options]
A job file is an XML file that specifies all settings related to an encoding

session. Job files can be created via the GUI application (see Chapter 6), or
edited with any text or XML editor.

You can specify additional arguments and flags on the command line. These
are described in the next section, “Command-Line Reference” on page 74.

Batch encoding

To perform batch encoding of many input files, use a directory name as the
input and a directory name as the output. For example:

hmprod -j myjob.xml -i c:\inputs\ -0 c:\outputs\ ...

This creates one output file for each input file using the same settings for
every file. Each valid source file in the input directory will be encoded
sequentially.

Command-Line Reference

The command-line interface has several flags and arguments that you should
be familiar with before doing any encoding from the command line. To
simplify command-line use and to make it easier to reuse encoding settings,
you can use job files to define all of the encoding settings.

Helix Mobile Producer Command-Line Flags

The command-line flags are listed and described in the following paragraphs.
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Job file parameters

The job file options are listed in the following table:

Job File Option

Syntax -job <jobfile>
Description: Denotes the XML job file that specifies all of the encoding
parameters.

Note that the job filename can be a relative or absolute path on a
network or local drive. If it is relative, the location must be relative
to the current working directory (the directory you executed
producer from).

Limitation: This flag cannot be used with any option other than Logging
Category (-lc)

Example: -j MyJob.hmpj

Inputs
The possible options for audio/video inputs are the following:
« -i  Input file or directory
«-d Duration
« -st Start time
+-et End time
The file or directory input option is described in the following table:

Input File Option

Syntax -i

Description: A filename pointing to a file or directory of files to be encoded.
The input file may be one of the following:

- A single filename pointing to a supported input media type

- An input directory name (batch)

Note that the job filename can be a relative or absolute path on a
network or local drive. If it is relative, the location must be relative
to the current working directory (the directory you executed
producer from).
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Batch
Encoding

Input File Option

If a directory is specified, a batch encode is performed where each
input file is encoded sequentially one after another.

All files are used as input and are output to the directory as
defined in the Output File option (-0).

If the output directory is not specified, output files are placed in
the same directory as the input file.

If the input filename does not exist or, for directory, does not
resolve to at least one valid input file, an error is generated and

encoding stopped.

Supported
input file
formats

The following list describes the input file types supported and the
platforms they are supported on:

- Windows

- Any compressed and uncompressed file types supported by
DirectShow,

- Any compressed and uncompressed file types supported by
QuickTime.

The later two items under Windows include compressed AVI,
compressed QT, MPEG1, MPEG2, MP3 and many other
compressed and uncompressed file formats.

Note that for MPEG2 you need to have an MPEG2 DirectShow
filter which is installed by many software DVD players.

Limitation:

This tag cannot be used in conjunction with a job that specifies
server destinations.

Examples:

-i myfile.avi
-i c:\media\moviel.avi
-i c:\media\

The duration option is described in the following table:

Syntax

Duration Option
-d

Description:

Specifies the amount of elapsed time before which encoding will
stop when encoding from an input audio or video device. May also
be used with file inputs.

The formatis d:h:m:s.ms.

Note that if the duration is not provided, or if the value is zero, the
duration is infinite.

Examples:

-d 90 (90 seconds)
-d 1:00:00 (1 hour)
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The start time option is described in the following table:

Start Time Option

Syntax -st
Description: Specifies the start time within a file to begin the encode.
The default value is 0 (beginning of the file)
The formatis d:h:m:s.ms.
May be used with either duration (-d) or End Time (-et), or by itself
(to indicate the end time is the end of the file).
Limitation: -
Example: -st 90 (begins encoding from 90 seconds into the file)

-st 1:00:00 (begins encoding from 1 hour into the file.)

The end time option is described in the following table:

End Time Option

Syntax -et

Description: Specifies the end time within a file to end encoding.
The formatis d:h:m:s.ms.
Note that if the end time is not provided, the end time will be the
end of the file. In the same way, If the end time is beyond the
duration of the file, then encoding will stop at the end of the file
and a warning will be logged.

Limitation: This flag cannot be used with -d

Examples: -d 90 (stop encoding at 90 seconds from the beginning of the file.)
-d 1:00:00 (stop encoding at 1 hour into the file.)

Outputs

The option described in the following table defines the file and server

destinations and other outputs generated by the command line.

Output Option
Syntax -0
Description: The output filename or directory name.
Note that this flag is optional for file inputs (-i).
Limitation: See below.
Examples: -0 C:\Windows\Desktop\movie.rm

-0 \home\johndoe\commercialbreak.rm
-0 "C:\My Movies"
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The value is interpreted as follows:

Input/Output interpretation

Input (-i) Output (-o0)

existing file valid filename

existing file or  existing
directory directory
directory valid filename

existing file Omitted

or directory

Action

The output will be written to the requested
output filename

The output filename for each input file is derived
from the input filename by replacing the input
file extension with the appropriate output
extension and written to the specified output
directory.

This is interpreted as an error since it is unclear if
the specified output was intended to be a
directory or a filename. Helix Mobile Producer
logs an error and stops encoding.

The output filename for each input file is derived
from the input filename by replacing the input
file extension with the appropriate output
extension and written to the same directory as
the input file.

Note: The file name or the directory name can be a relative or

absolute path on a network or local drive. If a relative path is

provided, the location is relative to the current working

directory (the directory you executed producer from).

Warning! File size limits - If the output file size reaches 4 GB
(limit of RealAudio/RealVideo file format) the output file is
automatically rolled and a new file is started. The new file is

appended with a number (e.g. moviel.rm).

There is no archiving or file rolling support for non-rm output

formats.

Clip information

The clip information includes the descriptive metadata that is inserted into
RealAudio/RealVideo files such as Title, Author and Copyright.
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The title option is described in the following table:

Title Option

Syntax -t

Description: Title to be inserted into all output media clips and live streams.
The title value can be any user supplied string up to 255 bytes (i.e.
255 single-byte characters). For RealMedia, the string is ASCII. For
3GPP v6, the string is UTF-8.
Example:
This string gets inserted into the header of all output
RealAudio/RealVideo and 3GPP v6 files and live streams. This
information is exposed to the user through the player's Clip Info
region.

Limitation: =

Example: -t "My Clip Title"

The author option is described in the following table:

Syntax

Author Option

-a

Description:

Author to be inserted into all output media clips and live streams.
Default:

No default

Values:

Any user supplied string up to 255 bytes (i.e. 255 single-byte
characters).For RealMedia, the string is ASCIL For 3GPP v6, the
string is UTF-8.

Example:

-a "William Shakespeare"

Details:

This string gets inserted into the header of all output
RealAudio/RealVideo and 3GPP v6 files and live streams. This
information is exposed to the user through the player's Clip Info
region

Limitation:

Examples:
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The copyright option is described in the following table:

Syntax

Copyright Option

-C

Description:

Copyright to be inserted into all output media clips and live
streams.

Default:

No default

Values:

Any user supplied string up to 255 bytes (i.e. 255 single-byte
characters). For RealMedia, the string is ASCIIL For 3GPP v6, the
string is UTF-8.

Example:

-c "RealNetworks(c) 2004 "

Details:

This string gets inserted into the header of all output
RealAudio/RealVideo and 3GPP v6 files and live streams. This
information is exposed to the user through the player's Clip Info
region.

Limitation:

Examples:

The keywords option is described in the following table:

Syntax

Keywords Option
-k

Description:

Keywords to be inserted into all output media clips and live
streams.

The keywords value can be any user supplied string up to 255 bytes
(i.e. 255 single-byte characters).

For RealMedia, the string is ASCIL

For 3GPP v6, the string is UTF-8.

Note that this string gets inserted into the header of all output
RealAudio/RealVideo and 3GPP v6 files and live streams.

Limitation:

Example:
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Description Option
-de

Description:

Description to be inserted into all output media clips and live
streams.

The description value can be any user supplied string up to 1023
bytes in size (i.e. 1023 single-byte characters).

For RealMedia, the string is ASCIL

For 3GPP v6, the string is UTF-8.

Example:

Note that this string gets inserted into the header of all output
RealAudio/RealVideo and 3GPP v6 files and live streams.

Limitation:

Any text beyond the 64k character limit is truncated.

Example:

-de "A story about a galaxy far far away..."

The rating option is described in the following table:

Rating Option
Syntax -r
Description: Defines the age range for which the content is applicable to.
Limitation: See tables below
Rating Option for 3GPP v6
Syntax -r [RatingBody:]RatingCriteria[,RatingInfo]
RatingBody is the rating body that defines the rating criteria being
used. The MPAA for example.
RatingCriteria is the rating for the content, such as PG13 or G.
RatingInfo is a text description of the rating.
Description: Defines the rating body, the rating criteria, and a description of
the rating.
Possible values: see table below.
Limitation: The only required parameter is the RatingCriteria. If the
RatingBody is not entered, it is left blank.
Examples: -rR
-r MPAA:PG13

-r BBFC:R18,"Suitable only for adults."
-r PG,"Parental guidance suggested."
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3GPP v6 Possi

ble Rating Values

Rating Body: ~ MPAA BBFC OFLC

Ratings: G

U G

PG PG PG
PG13 12 M

15 MA

NC17 18 R

R18 X

In the case of 3GPP, the Rating box specifies both the rating body and the 4 character
code for the rating. The table below defines some example values, as listed on

htep://www.movie-

ratings.net/. See the 3GPP v6 Spec for more information. It is

possible to specify any two 4-character codes for this option, separated by a comma,

and followed by a t

Syntax

ext description

Rating Option for RealMedia

-r

Description:

Possible Values: any integer from O to 6 as follows:
0 - No Rating

1 - All Ages

2 - Older Children

3 - Younger Teens

4 - Older Teens (15 & up)

S - Adult Supervision Recommended

6 - Adults Only

Limitation:

If this option is not included in the command line or the property
is specified as "Not Rated" then the Content Rating metadata
field is not added to the output RealAudio/RealVideo file.

For RealMedia: If this property is not passed on the command line
or the property is specified as "Not Rated" then it is not set in the
SDK and thus never gets added to the RealAudio/RealVideo file.

Example:

Logs

-r0

The command-line will print out errors and warnings to the console as they

are encountered.

Each type of message will be preceded by a tag as shown in

the examples below:

ERROR: "MyJob.hmpj" is not a valid job file.
WARNING: The input file duration is shorter than the specified end time. The

encode will st

82

op at the end of the file.



CHAPTER 9: Using the Command-Line Encoder

Specific options

Options in this section provide information about the system configuration.
This information is useful in settings up an encoding session:

«-g Quite mode
+-h  Print help
« -pd Print devices
« -v  Print version
The quiet mode option is described in the following table:

Quiet options

Syntax -q

Description: Prevents any output from being printed to the screen ever.
this option can be useful if you are running the command line
application from within another application that fails if data
output to standard output or standard error.

The print help option is described in the following table:

Print Help Option
Syntax ‘-h [Top] - [Top of Section]
Description: ‘ Display short help on screen.

The print devices option is described in the following table:

Print Devices Option

Syntax -pd [Top] - [Top of Section]

Description: This is an informational option that lists audio and video
device information for the system. The intention is that the
user can take this information to edit the devices specified
in their job file.

Note that only the first ten detected inputs are displayed.

Print Version Option

Syntax -v [Top] - [Top of Section]

Description: This option prints version information for the command

line application.
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Stopping the encoding session,

To stop the current encoding session press Ctrl+C. This command stops the
current encoding session and save the resulting output files (Note that some
time may be required to merge SureStream files).
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USING THE BATCH PROCESSOR

Helix Mobile Producer Professional gives you the ability to queue up

encoding jobs and process them in batches.

Getting Started

To switch to batch processing mode, click Mode>Batch Processor. The
following window is displayed:

Batch Encoder Window

2% Helix Mobile Producer Professional Edition powered by Envivio 11.0 - (build#531) B o [ A
File Edit Mode Help

Input Dutput | Status ~Clip information

No clip information

—Jab Detail
Job Type: -
Audio Codec: -

Wideo Codec: -

Audiences: -

3| AddinputFiles. Delete

Status: Feady to encode

Start Stop

A

Note: You can also toggle between the batch processor and the
Helix Mobile Producer by pressing Ctrl+M (Main Interface) or
Ctrl+B (Batch encoder).
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Selecting a Job

You must have saved your own jobs if you want to use them in batch
processing mode.

To select a job, click AddJob... and select the job you want to use.

Note: If the selected job contains an input file and output file,
and if you have selected the Respect job-defined input files...
option (see “Respect Job-Defined Input Files...” on page 72)
they become the first task in the batch for that job.

Then you can:

+ Add or delete input file(s)

« Specify the clip information for each file, or for all the files included in a
job. See “Setting Metadata” on page 69 for more details on metadata
parameters.

Tip: You can view the job properties by selecting the job name.
The job properties are displayed in the Job Details panel.

Adding Input Files

To add media to the job, click Add Inputfiles... and select the file you want to
encode.

Deleting Input Files

To remove a media from the job, select the input file you want to delete then
click Delete.

Specifying the Output File Name

You can specify the MPEG-4 output file name and path by clicking the input
file name. Then you can change the file name and path.

Note: By default, the output directory is the same as the input
directory. You can specify a custom directory from the
Preferences dialog box (see “Setting Preferences” on page 72).

Starting the batch encoding

To start the batch encoding, click the Start button.
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Understanding the Batch Encoding Process

As each job is run, Helix Mobile Producer applies the selected job options, and
starts encoding.

E’.‘ Helix Mobile Producer powered by Envivio 11.0 - {build#515) i i |EI|1|

File Edit Mode Help

Job Olutput | Statug - Clipinfarmation
(- D:5Program FileshEn.. Title:

b ExtMediatflower... E:\Media\flowers. 3gp Complete

- EfMediavsalma... E:\Mediahzalmon. 3gp Encoding... 71

Authar,

Copyright:

[escription:

-
3
|
Kepwords: I

Fiating: I OFLC:G - l

—Job Detail
Job Type: 3GPPYE singlerate
Audio Codec: AMR-MNB
‘ideo Codec: H.264

Addob.. | Add Input Files.. | Delete || mudiences: defauit (30 kbps) i

Ready to encode

KrE4 Start Stop

The progress bar indicates the global progression of the jobs.

The progression of each job is described in the Status column. The status of
the job may be Queued, Encoding (followed by the encoded ratio) or Complete.

If an error occurs, Helix Mobile Producer stops the operation, records the
error, and starts the next job.
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APPENDIX

A

AUDIENCE FILE REFERENCE

This appendix describes the audience syntax. Each audience file records
settings about how clips are encoded. The information in this appendix allows
you to edit audience information to modify encoding settings.

Understanding Audiences

Each audience file defines a single audience for which a clip is encoded. Helix
Mobile Producer predefines a number of audiences that appear within the
graphical user interface when you click the Audio/Video streams tab. For
example, one audience may be for 20K. Each audience specifies the streaming
rates at which audio and video clips are encoded, along with other settings.

Audience Files

The audience files are stored in the audiences subdirectory under the
RealNetwork directory in the main Helix Mobile Producer installation
directory. Audience files use the file extension .xml. The beginning of their file
names correspond to the audience name in the graphical interface, followed
by the video encoder type, the audio encoder type and the total bit rate. For
example, when you select 3GPPvS5 as export type, the 20k GPRS Voice audience
in the graphical user interface stores its information in the file named
20k_GPRS_Voice-h264-amrnb_20kbps.xml.

Some settings in the audience files, such as the video codec, the frame rate,
keyframe interval, and buffer size, can be overridden using the GUI interface.
You can also edit audience files manually. This allows you to change audience
information used by the graphical interface or command line application
using a text editor or any automated process that can modify text files.

Tip: When creating a new audience file, RealNetworks
recommends that you start with an existing audience file that
you have renamed.
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Audience Section

The <audience> and </audience> tags encapsulate an audience section within
an audience file.

<audience xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
...all audience parameters

</audience>

Audience example

<audience xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<version>11.1</version>
<audienceName>20k GPRS Voice</audienceName>
<audienceAvgBitRate>20000</audienceAvgBitRate>
<information />
<audienceMaxBitRate>25000</audienceMaxBitRate>

<videoEncoder xsi:type="h264">
<keyFramePeriodInMs>5000</keyFramePeriodInMs>
<maxFrameRate>5</maxFrameRate>
<encodingComplexity>high</encodingComplexity>
<videoMode>normal</videoMode>
</videoEncoder>

<audioEncoder xsi:type="amrnb">
<bitRate>5150</bitRate>
<useDTX>false</useDTX>
</audioEncoder>

</audience>

Video and Audio Streams
Each audience template has video and audio streams. The video section starts
and ends with <videoEncoder> and </videoEncoder> tags. The audio section
starts and ends with <audioEncoder> and </audioEncoder> tags.

Video Stream examples

For More Information: Appendix C lists the video codecs along
with the parameters values.
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MPEG-4 SP encoder
<videoEncoder xsi:type="mpegé4sp">
<keyFramePeriodInMs>5000</keyFramePeriodInMs>
<maxFrameRate>5</maxFrameRate>
<encodingComplexity>high</encodingComplexity>
<videoMode>normal</videoMode>

</videoEncoder>

H.263 encoder
<videoEncoder xsi:type="h263">
<keyFramePeriodInMs>5000</keyFramePeriodInMs>
<maxFrameRate>5</maxFrameRate>
<encodingComplexity>high</encodingComplexity>
<videoMode>normal</videoMode>

</videoEncoder>

H.264 encoder

<videoEncoder xsi:type="h264">
<keyFramePeriodInMs>5000</keyFramePeriodInMs>
<maxFrameRate>5</maxFrameRate>
<encodingComplexity>high</encodingComplexity>
<videoMode>normal</videoMode>

</videoEncoder>

Real Media encoder

<videoEncoder xsi:type="realVideo10">
<videoMode>normal</videoMode>
<keyFramePeriodInMs>5000</keyFramePeriodInMs>
<encodingComplexity>high</encodingComplexity>
<maxFrameRate>15</maxFrameRate>

</videoEncoder>

Audio Stream Examples

For More Information: Appendix C lists the audio codecs along
with the parameters values.

AAC encoder

<audioEncoder xsi:type="aac">
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<bitRate>128000</bitRate>

<useMS>true</useMS>

<advAudio>
<channelMode>stereo</channelMode>
<samplingRate>44.100000</samplingRate>

</advAudio>

</audioEncoder>

AAC Plus encoder

<audioEncoder xsi:type="aacPlus">
<bitRate>16000</bitRate>

</audioEncoder>

Enhanced AAC Plus encoder

<audioEncoder xsi:type="enhancedAacPlus">
<bitRate>48000</bhitRate>

</audioEncoder>

AMR-NB encoder

<audioEncoder xsi:type="amrnb">
<bitRate>12200</bitRate>
<useDTX>false</useDTX>

</audioEncoder>

AMR-WB encoder

<audioEncoder xsi:type="amrwb">
<bitRate>15850</bhitRate>
<useDTX>true</useDTX>

</audioEncoder>

QCELP encoder

<audioEncoder xsi:type="qcelp">
<bitRate>14000</bitRate>

</audioEncoder>

MP3 encoder

<audioEncoder xsi:type="mp3">
<bitRate>96000</bitRate>

</audioEncoder>



RealAudio encoder

<audioEncoder xsi:type="realAudio">
<codecFlavor>cook19</codecFlavor>

</audioEncoder>

APPENDIX A: Audience File Reference
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APPENDIX

B

JOB FILE REFERENCE

This appendix provides a reference for job files created in Helix Mobile
Producer, describing the format and syntax of job file encoding parameters
for audio and video input. It shows the basic structure of a job file and gives
you details about the different sections of a job file.

Creating Job Files

A job file is an XML file that uses the following format:

<job build="539" exportType="3gpp2" version="11.1"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<clipInformation>
<title />
<author />
<copyright />
<mediaKeywords />
<description />
<mediaRating=MPAA:G</mediaRating>
</clipInformation>
<inputs>
<input xsi:type="avFileInput">
<fileName />
<prefilters>
<audioPreFilters />
<videoPreFilters>
<enableResize>true</enableResize>
<resizeWidth>176</resizeWidth>
<resizeHeight>144</resizeHeight>
</videoPreFilters>
</prefilters>
</input>
</inputs>

<outputs>
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<fileOutput>
<fileName />
</fileOutput>
</outputs>
<encodingParameters>
<rateControlMode>cbr</rateControlMode>
<number0fPass>2</numberOfPass>
<encodeVideo>true</encodeVideo>
<encodeAudio>true</encodeAudio>
<exportSettings>
<progressiveDownload>true</progressiveDownload>
<hinted>true</hinted>
<MTUSize>1400</MTUSize>
</exportSettings>
<audiences>
<audience>
<version>11.1</version>
<audienceName>44k CDMA Voice</audienceName>
<audienceAvgBitRate>44000</audienceAvgBitRate>
<information />
<audienceMaxBitRate>44000</audienceMaxBitRate>
<videoEncoder xsi:type="mpegé4sp">
<keyFramePeriodInMs>5000</keyFramePeriodInMs>
<maxFrameRate>5</maxFrameRate>
<encodingComplexity>high</encodingComplexity>
<videoMode>normal</videoMode>
</videoEncoder>
<audioEncoder xsi:type="qcelp">
<bitRate>14000</bitRate>
</audioEncoder>
</audience>
</audiences>

</encodingParameters>

</job>

put Parameters

This section defines the properties, or parameters, that you can set for import
file formats and live capture sources for audio and video input. Note that
some of these properties are optional.



File Input
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You can set the file name parameter for file input, as shown in the following

table and example.

Parameter ID

file name

Example

<input>

File Name Parameter

<file name="D:\movies\my_movie.avi"/>

</input>

Definition Value
Input file for offline encoding Absolute path to the input
file name

Note: Helix Mobile Producer does not support live encoding of
file input for broadcast output.

Live Capture Input

The live capture input parameters you can set for Helix Mobile Producer are
listed and defined in the following table. You can set these parameters as

shown in the example after the table.

Parameter ID

udioDevicelID

Live Capture Input Parameters

Definition

Input audio capture source

Value

Optional

videoDevicelID

Input video capture source

videoDeviceWidth

Width of the input video
image in pixels

videoDeviceHeight

Example

Height of the input video
image in pixels

<input xsi:type="captureInput">
<audioDeviceID>0</audioDeviceID>
<videoDeviceID>0</videoDeviceID>
<videoDeviceWidth>720</videoDeviceWidth>
<videoDeviceHeight>576</videoDeviceHeight>

<prefilters>

<audioPreFilters />
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<videoPreFilters>
<enableResize>true</enableResize>
<resizeWidth>352</resizeWidth>
<resizeHeight>288</resizeHeight>
</videoPreFilters>

</prefilters>

</input>

Prefilters

The prefilters you can set for Helix Mobile Producer are shown in the
following examples.

For More Information: The prefilters parameters are listed at the
end of the Input parameters. For more iinformation on these
parameters, refer to “Setting Audio and Video Filters” on page
60.

Example

<inputs>
<input xsi:type="avFileInput">
<fileName>E:\contents\my_movie.avi</fileName>
<prefilters>
<audioPreFilters>
<audioGain>10</audioGain>
<audioBalance>20</audioBalance>
</audioPreFilters>
<videoPreFilters>
<enableCropping>true</enableCropping>
<croppingleft>0</croppinglLeft>
<croppingTop>0</croppingTop>
<croppingWidth>720</croppingWidth>
<croppingHeight>480</croppingHeight>
<enableResize>true</enableResize>
<resizeWidth>720</resizeWidth>
<resizeHeight>480</resizeHeight>
<enableDeinterlace>true</enableDeinterlace>
<enableInverseTelecine>true</enableInverseTelecine>
<inverseTelecineFieldOrder>1</inverseTelecineFieldOrder>
<enableLogoInsertion>true</enableLogoInsertion>
<logolInsertionFile>E:\Documents\logo.bmp</logoInsertionFile>
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<logoInsertionlLeft>25</logoInsertionlLeft>
<logoInsertionTop>30</logoInsertionTop>
<enableNoiseReductionAdjustment>true</enableNoiseReductionAdjustment>
<noiseReductionAdjustmentlLevel>2</noiseReductionAdjustmentLevel>
<enableBrightnessAdjustment>true</enableBrightnessAdjustment>
<brightnessAdjustmentLevel>10</brightnessAdjustmentLevel>
<enableContrastAdjustment>true</enableContrastAdjustment>
<contrastAdjustmentlLevel>-10</contrastAdjustmentLevel>
<enableGammaAdjustment>true</enableGammaAdjustment>
<gammaAdjustmentRed>10</gammaAdjustmentRed>
<gammaAdjustmentGreen>-10</gammaAdjustmentGreen>
<gammaAdjustmentBlue>40</gammaAdjustmentBlue>

</videoPreFilters>

</prefilters>

</input>

</inputs>

Output Parameters

This section defines the parameters that you can set for audio or video output
files or broadcasts. Note that some of these properties are optional.

File Output

You can set the file name parameter for file output, as shown in the following
table and example.
File Name Parameter
Parameter ID Definition Value

file name Output file for offline encoding | Absolute path to the output
file name
Example

<output>
<file name="output.3gp"/>
</output>

Helix Broadcast Output

There are a number of Helix broadcast output parameters that you can set, as
shown in the following examples.
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For More Information: For more information on Helix Broadcast
parameters, refer to “Helix Broadcast Mode” on page 36.

Push Account-Based

Example

<outputs>

<broadcastOutput xsi:type="pushServerAccountBased">
<streamname>live.rm</streamname>
<address>192.168.105.187</address>
<port>80</port>
<username>admin</username>
<password>toto</password>
<savePassword>true</savePassword>
<transport>udp</transport>
<listenAddress>0</listenAddress>
<fecPercent>0</fecPercent>
<fecOffset>0</fecOffset>
<allowResends>true</allowResends>
<enableTCPReconnect>true</enableTCPReconnect>
<TCPReconnectInterval>30</TCPReconnectInterval>

</broadcastOutput>

</outputs>

Push Password-Only

Example

<outputs>
<broadcastOutput xsi:type="pushServerPasswordOnly">

<streamname>live.rm</streamname>
<address>192.168.105.187</address>
<port>3020</port>
<endPort>3050</endPort>
<password>envivio</password>
<savePassword>true</savePassword>
<transport>udp</transport>
<listenAddress>0</listenAddress>
<fecPercent>0</fecPercent>
<fecOffset>0</fecOffset>
<allowResends>true</allowResends>
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<enableTCPReconnect>true</enableTCPReconnect>
<TCPReconnectInterval>30</TCPReconnectInterval>
</broadcastOutput>

</outputs>

Push Multicast

Example

<outputs>

<broadcastOutput xsi:type="pushServerMulticast">
<streamname>live.rm</streamname>
<port>3020</port>
<endPort>3050</endPort>
<password>envivio!</password>
<savePassword>true</savePassword>
<transport>udp</transport>
<listenAddress />
<multicastAddress>224.224.224.224</multicastAddress>
<multicastTTL>3</multicastTTL>
<fecPercent>0</fecPercent>
<fecOffset>0</fecOffset>
<metadataResendInterval>30</metadataResendInterval>

</broadcastOutput>

</outputs>
Pull

Example

<outputs>

<broadcastOutput xsi:type="pullServer">
<streamname>live.rm</streamname>
<listenAddress>0</listenAddress>
<listenPort>3031</listenPort>
<password>envivio!</password>
<savePassword>true</savePassword>
<serverTimeout>30</serverTimeout>

</broadcastOutput>

</outputs>
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RTP Broadcast Output

There are five RTP broadcast output parameters that you can set, as shown in
the following table and example.

RTP Broadcast Output Parameters

Parameter ID Definition Value
broadcastOutput Broadcast mode selection rep
xsi:type
sdpFileName Session description protocol file (or Absolute path to
announce file), which provides the announce file
information about a streamed Web
broadcast
destinationAddress |IP address for a multicast IP address
destinationPort Destination port for RTP broadcast Port number
mode
TTL Amount of time left until a live multicast | 1 through 15
begins
Example
<outputs>

<broadcastOutput xsi:type="rtp">
<sdpFileName>E:\workspace\hmp11_beta\zola2\bin\Release/live.sdp</sdpFi
leName>
<destinationAddress>127.0.0.1</destinationAddress>
<destinationPort>5050</destinationPort>
<TTL>3</TTL>
</broadcastOutput>

</outputs>

Export Settings

The export settings you can set for Helix Mobile Producer are shown in the
following examples.

For More Information: The export settings parameters are listed
in the encoding parameters. For more iinformation on these
parameters, refer to “Setting Export Parameters” on page 65.
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Example

<clipInformation>
<title />
<author />
<copyright />
<mediaKeywords />
<description />
<mediaRating>Not rated</mediaRating>

</clipInformation>

The metadata you can set for Helix Mobile Producer are shown in the
following examples.

For More Information: For more iinformation on these
parameters, refer to “Setting Metadata” on page 69.

Example

<clipInformation>
<title>My clip</title>
<author>Unknown</author>
<copyright />
<mediaKeywords>Music</mediaKeywords>
<description>Music clip</description>
<mediaRating>All ages</mediaRating>

</clipInformation>
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C

AUDIO CODEC REFERENCE

This appendix provides a reference for all codecs used by Helix Mobile
Producer. The first part describes all RealAudio codecs, broken down into
separate tables for voice, mono music, stereo and surround sound music
codecs. The second part describes all the other codecs.

RealAudio Codecs

Using the RealAudio Codec Reference Tables

The codecs below are grouped into tables according to the type of application
such as voice or music and provide detailed information about each codec.

RealAudio Codec Name

This column describes the name of the codec as it appears in the Audiences
dialog. (To access the Audience Templates dialog, click the Audio/Video
streams tag and click the Template name you want to use.)

The name gives you vital information about the codec: the bit rate for the
codec, the type of audio the codec is suited for, and if the codec is a “high
response” codec.

High response codecs cover high frequency sounds, such as a flute, than
normal codecs at the same bit rate. But they don’t cover low frequencies, such
as a bass drum, as well as normal codecs.

RealAudio Codec ID

The codec flavor column identifies the codec number you can use when
creating XML job files.

Sampling Rate

The Sampling Rate column lists the codec’s optimum sample rate. Using a
codec’s optimum sampling rate in your audio source file ensures that the
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audio stays synchronized with other media and prevents pitch shifting during
audio resampling. Audio quality degrades if you use lower than the optimum
sampling rate.

Audio input should be set at the same sample rate as required by the desired
output codec. In the case of SureStream encoding, the input sample rate
should be equal or greater than the largest sample rate of all codecs in
included in the output.

If you use a higher sampling rate when creating the source audio, it is best to
use a multiple of the optimum rate. If the optimum rate is 8 kHz, for example,
use a higher rate of 16 kHz or 32 kHz. When in doubt, use a CD-quality
sampling rate of 44.1 kHz for your source audio.

Frequency Response

A codec with a higher frequency response reproduces a wider range of sound
than a codec with a lower response. High Response is indicated after the coder

name

Frequency response measures how much of the original audio’s frequency
range will be used in creating the RealAudio clip. Thus, the codec does not
enhance produced audio’s quality; it always results in a clip of equal or lower
quality than the original audio. For example, if the original audio has an 8
kHz frequency response, encoding it with a codec that has a frequency
response of 10 kHz produces a clip that still has a response of 8 kHz.

For More Information: The audio preparation chapter of
RealNetworks Production Guide has an expanded list that covers
all RealAudio codecs, including obsolete codecs no longer used
by Helix Producer.

Compatibility

Some codecs are available for use with early versions of the Real Player.
Compatibility is indicated below each codec type.

Voice Codecs

Helix Mobile Producer uses a voice codec when you encode a voice-only or
voice-with-music clip. The lowest-speed voice codec normally used with
RealAudio is 16 kbps. The lower-speed codecs can be used as “duress” streams
in SureStream clips. They are also used to encode soundtracks for low-
bandwidth RealVideo clips.
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Available Voice Codecs

Helix Mobile Producer offers several codecs designed specifically for encoding

voice.
RealAudio Voice Codecs
Codec Name Codec ID Sampling Rate
5 Kbps voice sipr2 8 kHz
6.5 Kbps Voice sipr0 8 kHz
8.5 Kbps Voice | siprl 8 kHz
16 Kbps Voice sipr3 16 kHz
32 Kbps Voice cook?7 22.05 kHz
64 Kbps Voice cook14 44.1 kHz

Player Compatibility

« The sipr 6.5Kbps and 8.5Kbps codecs are compatible with RealPlayer 4
and later.

» The sipr 5Kbps and 15 Kbps codecs are compatible with RealPlayer 5 and
later.

« The cook 32Kbps and 64Kbps codecs are compatible with RealPlayer G2
and later.

Music Audio Codecs

Music codecs create a higher quality of sound for audio recordings than voice
codecs. Music Audio codecs are designed to encode audio with a larger pitch
variance than voice. You will capture a broader, fuller sound with codecs
designed for higher bit rates, but your files will be larger.

The lower-speed codecs can be used as “duress” streams in SureStream clips,
and to encode soundtracks for low-bandwidth RealVideo clips. When there are
two versions of a codec, Helix Producer uses the high response version by

default.

About High-Response Codecs

The 20 kbps and 32 kbps music codecs come in two flavors. Helix Producer by
default uses the “high response” versions, which are the better codecs for most
situations. But you can also use the “normal response” versions.

107



Helix Mobile Producer and Helix Mobile Producer Live User’s Guide

The high response codecs cover a larger frequency spectrum than the normal
response versions. Sometimes, the high response version has twice the range
as the normal codec. This means it provides crisper sound and is better at
capturing high frequencies. With symphonic music, for example, the high
response codec gets more of the flute and piccolo. It can produce more
distortion than the normal response codec with voices and loud sounds such
as drums, though.

If you are encoding music with a diverse range of frequencies, stick with the
high response codecs. If you notice distortion, compare your results with a
clip that uses the normal response codecs. The best tool for determining
which codec to use is your ear. Listen carefully for minute differences in how
the clip sounds. It also helps to have other people listen. Our own ears have
different frequency responses, too.

The slowest stereo codec is 12 kbps. Stereo codecs don’t go lower than that
because they would not have enough frequency response for adequate sound.

Available Audio Codecs

The wide of available codec bit rates allow you encode your files for your exact
audience needs.

Music Audio Codecs

Codec Name Codec ID Sampling Rate
6 Kbps Music cook8 8kHz

8 Kbps Music cook0

11 Kbps Music cookl 8 kHz

16 Kbps Music cook2 8 kHz

20 Kbps Music cook3 11.025 kHz
20 Kbps Music High Response cook15 22.05 kHz
32 Kbps Music cook4 22.05 kHz
32 Kbps Music High Response cook16 44.1 kHz
44 Kbps Music cook5 44.1 kHz
64 Kbps Music cook6 44.1 kHz

Player Compatibility
« All Music Audio Codecs are compatible with RealPlayer G2 and later.
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Stereo Music Audio Codecs

Helix Mobile Producer contains an array of RealAudio codecs that are
optimized for stereo music. These RealAudio codecs enable you to stream
high-quality stereo music at a wide range of bandwidths.

Because the outputis designed for dual speaker systems, your music will reach
a large audience with varying systems.

Available Music Audio Codec

A variety music audio codecs are now available in Helix Mobile Producer.

Stereo Music Audio Codecs

Codec Name Codec ID Sampling Rate
12 Kbps Stereo Music cook26 11.025 kHz
16 Kbps Stereo Music cookl17 22.05 kHz
20 Kbps Stereo Music (older version) cook9 11.025 kHz
20 Kbps Stereo Music cook18 22.05 kHz
20 Kbps Stereo Music High Response cook19 22.05 kHz
32 Kbps Stereo Music (older version) cook10 22.05 kHz
32 Kbps Stereo Music cook20 22.05 kHz
32 Kbps Stereo Music High Response cook21 44.1 kHz
44 Kbps Stereo Music (older version) cook11 22.05 kHz
44 Kbps Stereo Music cook22 44.1 kHz
44 Kbps Stereo Music High Response cook23 44.1 kHz
64 Kbps Stereo Music (older version) cook12 44.1 kHz
64 Kbps Stereo Music cook24 44.1 kHz
96 Kbps Stereo Music (older version) cook13 44.1 kHz
96 Kbps Stereo Music cook25 44.1 kHz
64 kbps Stereo Music - RealAudio 10 raac( 44.1 kHz
96 kbps Stereo Music - RealAudio 10 raacl 44.1 kHz
128 kbps Stereo Music - RealAudio 10 raac2 44.1 kHz
160 kbps Stereo Music - RealAudio 10 raac3 44.1 kHz
192 kbps Stereo Music - RealAudio 10 raac4 44.1 kHz
256 kbps Stereo Music - RealAudio 10 raac5 44.1 kHz
320 kbps Stereo Music - RealAudio 10 raac6 44.1 kHz
44 kbps Stereo Surround cook29 22.05 kHz
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Stereo Music Audio Codecs (continued)

Codec Name Codec ID Sampling Rate
64 kbps Stereo Surround cook27 44.1 kHz
96 kbps Stereo Surround cook28 44.1 kHz
128 kbps Stereo Surround - RealAudio 10 raac’ 44.1 kHz
160 kbps Stereo Surround - RealAudio 10 raac8 44.1 kHz
192 kbps Stereo Surround - RealAudio 10 raac9 44.1 kHz
256 kbps Stereo Surround - RealAudio 10 raacl0 44.1 kHz
320 kbps Stereo Surround - RealAudio 10 raacll 44.1 kHz
96 kbps 5.1 Multichannel - RealAudio 10 cook30 22.05 kHz
128 kbps 5.1 Multichannel - RealAudio 10 cook31 44.1 kHz
180 kbps 5.1 Multichannel - RealAudio 10 | cook32 44.1 kHz
264 kbps 5.1 Multichannel - RealAudio 10 cook33 44.1 kHz

Player Compatibility

- All RealAudio 10 codecs are compatible with RealPlayer 10 and later.

- All other stereo music codecs are compatible with RealPlayer G2 and later.

Other Audio Codecs

Several AMR, AAC, QCELP and MP3 audio codecs are now available in Helix
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AMR, AAC, QCELP and MP3 Audio Codecs

Codec Name Codec ID Sampling Rate
7.4 kbps AMR Narrow Band amrnb 8 khz
7.95 kbps AMR Narrow Band amrnb 8 khz
10.2 kbps AMR Narrow Band amrnb 8 khz
12.2 kbps AMR Narrow Band amrnb 8 khz
6.6 kbps AMR Wide Band amrwb 16 khz
8.85 kbps AMR Wide Band amrwb 16 khz
12.65 kbps AMR Wide Band amrwb 16 khz
14.25 kbps AMR Wide Band amrwb 16 khz
15.85 kbps AMR Wide Band amrwb 16 khz
18.25 kbps AMR Wide Band amrwb 16 khz
19.85 kbps AMR Wide Band amrwb 16 khz
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AMR, AAC, QCELP and MP3 Audio Codecs (continued)

Codec Name Codec ID Sampling Rate
23.05 kbps AMR Wide Band amrwb 16 khz
23.85 kbps AMR Wide Band amrwb 16 khz
AAC Low Complexity aac variable
aacPlus aacPlus variable
Enhanced aacPlus enhancedAac | variable

Plus
QCELP half-rate qeelp 8 khz
QCELP full-rate qeelp 8 khz
MP3 mp3 variable
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D

FILE AND DEVICE COMPATIBILITY

This appendix provides a reference for compatibility among the various file
formats and numerous codecs supported by Helix Mobile Producer. It also
briefly addresses the compatibility of these formats and codecs with the
wireless mobile devices currently available.

File Format and Codec Compatibility

Helix Mobile Producer supports six audio codecs (not including the
RealAudio codecs), three video codecs, and seven file formats, not all of which
are compatible with one another. Refer to the following tables to determine
whether a given audio or video codec is supported within a particular file
format. An X in a codec’s column means that the codec is compatible with the
file type listed on the left in that row.

Audio Codec Compatibility
The following table provides a reference for audio codec compatibility.

Audio Codec Compatibility with Supported File Formats

Audio codecs

Enhanced
File formats AAC  AACPlus AACPlus AMR-NB AMR-WB QCELP RealAudio MP3
ISMA Profile 0 X
3GPP2 X
3GPP v5 X X X
3GPP v6 singlerate X X X X X
3GPP v6 multirate X X X X X
AMR X X
QCELP X
MP3 X
RealMedia X
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Video Codec Compatibility
The following table provides a reference for video codec compatibility.

Video Codec Compatibility with Supported File Formats

Video codecs

File formats RealVideo MPEG-4 SP H.264 H.263

ISMA Profile 0 X

3GPP2

3GPP v6 singlerate

X

3GPP vS X X
X
X

3GPP v6 multirate

AMR

QCELP

MP3

RealMedia X

Device Compatibility

Not all wireless mobile devices are compatible with all of the file formats and
codecs listed in the preceding tables. To determine which formats and codecs
a particular mobile device supports, see the manufacturer’s documentation
for that device.
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SNMP MONITORING

This appendix explains how to set up Simple Network Management Protocol
(SNMP) support for Helix Mobile Producer Professional and Helix Mobile
Producer Professional Live on Windows operating systems. It also includes a
reference table for supported SNMP objects that provide management
information about Helix Mobile Producer Professional and Helix Mobile
Producer Professional Live.

The SNMP Service

Helix Mobile Producer Professional and Helix Mobile Producer
Professional Live support the Windows SNMP service. You can use an SNMP
browser to monitor (remotely) computers running Helix Mobile Producer
Professional or Helix Mobile Producer Professional Live. Note that the
management information base (MIB) gets installed on your computer only if
the Windows SNMP service is already installed there.

If you decide to install the Windows SNMP service after installing Helix
Mobile Producer Professional or Helix Mobile Producer Professional Live,
you must uninstall Helix Mobile Producer, install the SNMP service, and then
reinstall Helix Mobile Producer.

Note: When you install Helix Mobile Producer
Professional or Helix Mobile Producer Professional Live,
select the Install SNMP agent check box on the final page of the
Setup wizard.

Installing the Windows SNMP Service

The following procedure shows you how to do an SNMP installation on a
computer running Windows 2000.
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SNMP Object Description
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» To install the SNMP service:

1. Insert the Windows 2000 or Windows XP CD into your disk drive.

2. Click Install Additional Components (Windows 2000)
or Install Optional Windows Components (Windows XP).

3. Click Management and Monitoring Tools.

4. Click Next.

This starts the installation process for the SNMP service.

Accessing the Helix Mobile Producer MIB

The MIB file is located in the Helix Mobile Producer Professional or
Helix Mobile Producer Professional Live installation directory, HMP-

MIB11.mib.

The following table provides the names and descriptions of all of the
monitored objects in the Helix Mobile Producer Professional MIB file.

SNMP object
cpuUsage
inputFile
audioDevice
videoDevice
targetPlayer

compatiblePlayers

outputFile
outputStream
outputSDPFile
clipDuration
timestamp
clipSize

totalBitRate

Monitored SNMP Objects
Description
CPU usage for the machine
Full path of the input source file, or "none"
Source audio device and port, or "none"
Source video device and port, or "none".
Player that this encode is targeted for (Players list)

Players that are compatible with this encode (Players
list)

Full path and name of output file, or "none"

Live broadcast destination

Full path and name of the output SDP file, or 'none'
Duration of the clip in hh:mm:ss format

Current time stamp in hh:mm:ss format

Total file size of the clip in bytes

Total bit rate of all streams in bits per second
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Monitored SNMP Objects (continued)

SNMP object

streamCount

Description

number of stream pairs in the active job.

The following objects are repeated for each audience.
X represents the audience index (from 1 to 8).

streamX_audioCodecName
streamX_audioCodecID

streamX_audioBitRate
streamX_audioFrequency
streamX_audioLatency

streamX_audioCPU

streamX_videoCodecName
streamX_videoCodecID
streamX_videoTargetBitRate
streamX_videoBitRate
streamX_videoLatency

streamX_videocpu
streamX_videoQualityIndex

streamX_videofps
streamX_videofpsMax

streamX_videofpsMin

Name of the audio codec; see audio codec tables in
Appendix C.

ID of the audio codec; see audio codec tables in
Appendix C.

Audio codec bitrate in bits per second
Frequency of the audio codec in Hz.
audio latency in milliseconds

Percentage of cpuUsage used for encoding this audio
stream.

The name of the video codec

The ID of the video codec.

The target video bit rate in bits per second
The current video bit rate in bits per second
the latency of the video stream in milliseconds

Percentage of cpuUsage used for encoding this video
stream.

Quality of the video as a percentage of the source
quality

Average frame rate in frames per second x 100.
Maximum frame rate in frames per second x 100.

Minimum frame rate in frames second x 100.
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AAC
Advanced Audio Coding, for MPEG-2 or MPEG-4 files.

ADSL
Asymmetric digital subscriber line. A high-speed Internet connection

carried over telephone lines.

AIFF, AIFC
Audio Interchange File Format. A format for storing digital audio samples

in a file. AIFC, a newer version of this format, can be used for compressing
audio files.

artifacts
Blemishes, noise, spots, or other flaws in video, audio, or image
production in MPEG files.

AVI
Audio/Video Interleaved. A multimedia file format.

bandwidth
Bandwidth has many meanings, depending on the context. It started as a

radio term and has been expanded to include other kinds of
communications. It is the numeric difference between the highest and
lowest frequencies of a radio band or channel.
Bandwidth means the same thing in relation to audio data, although in
most applications, the lowest frequency is sufficiently low enough to be
considered equal to zero. Hence, audio bandwidth usually means the
highest frequency of an audio signal or the highest frequency that can be
carried by an audio system.
Typical examples of bandwidth are 300-3,400 Hz for telephone lines, 20-
20,000 Hz for hi-fi systems, and 50-15,000 Hz for FM radio signals.

BIFS
Binary format for scenes. A set of nodes, based on VRML (Virtual Reality
Modeling Language), that make it possible to combine 2D and 3D
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graphics, natural and synthetic sound, audio and video information, and
stored and streamed material in one environment.

bit rate
The rate of data transmission over a computer network. Helix Mobile

Producer uses several bit rates. The target bit rate is the channel capacity
of the network. The maximum bit rate is a limit, less than the target bit
rate, that Helix Mobile Producer uses to fit data into the actual
bandwidth for a streaming server. The audio encoder uses an average
target bit rate and a maximum target bit rate for variable-bit-rate
encoding.

broadband
A general term for high-speed Internet connections provided by DSL lines,

cable modems, and T1 lines.

CBR
Constant bit rate.

CELP
Code Excited Linear Prediction. An audio-encoding scheme used for very

low-bit-rate encoding, mainly for speech.

CIF (pronounced “sif”)
Common Intermediate Format. A video display size (352 x 288 pixels) well

suited to higher bit rates.

codec
The software that encodes and decodes an audio or video file. The word is

a shortened form of coder-decoder or compression-decompression.

entropy
A measure of the degree of disorder or chaos in a system. In the context of

streaming media, as the entropy value increases, data compression
becomes more difficult.

hinted movies
Movies that can be streamed for broadcast over the Internet. A “hint

track” contains information about the media file that enables the server
to stream it properly.

I-frames
An MPEG-4 term for video key frames.
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Internet
An interconnected system of networks that connects computers around

the world, using the TCP/IP protocol.

ISO
International Organization for Standards. ISO is a network of the

national standards institutes of 146 countries. ISO standards are technical
agreements that provide the framework for compatible technology
worldwide.

Kbps
Kilobits per second. A standard measure of the rate of data transmission
over electronic devices.

key frame
A video frame that fully refreshes its contents and can be used as a

reference point for other frames in the video sequence. In MPEG
terminology, this is known as an I-frame.

motion estimation
For video, a method that estimates changes between frames.

.mov
The Apple QuickTime file name extension for movie files.

MPEG (pronounced “m-peg”)
As defined on the MPEG Web site, MPEG stands for Moving Pictures

Experts Group and is the name given to a family of international
standards for coding audiovisual information in a compressed digital
format. The MPEG family of standards includes MPEG-1, MPEG-2,
MPEG-4, MPEG-7, and MPEG-21, which are formally known as ISO/IEC-
11172, ISO/IEC-13818, ISO/IEC-14496, ISO/IEC-15938, and ISO/IEC
21000, respectively.

multimedia
A media presentation that contains some combination of text, graphics,
sound, video, and animation. Most personal computers can now display
multimedia content, and the source is typically a CD because the files are
large and require considerable storage capacity. The MPEG-4 format
enables broadcasters to deliver multimedia presentations over the
Internet.

121



Helix Mobile Producer and Helix Mobile Producer Live User’s Guide

N

122

noise
Random flaws that occur in audio or video content.

ixel

i A picture element, which is one point—or the smallest unit—in a graphic
image.

profile
A subset of the MPEG-4 standard that enables an MPEG-4 file to be as
complex as is necessary for a given software application. Vendors can use
profiles to implement only the part of the MPEG-4 standard that they
need, knowing that their files will be compatible with products from
other vendors.

QCIF (pronounced “q sif”)
Quarter Common Intermediate Format. A video display size (1/4 CIF =

144 x 176 pixels) well suited to lower bit rates.

RVLC
Reversible Variable Length Coding.

scene description
A description of the media in a streamed presentation and how the

content is to be reconstructed. The technical term for this is BIFS (binary
format for scenes).

set-top box
A device that connects a TV to the Internet so that Internet information

can be displayed on the TV screen. This term also is used to refer to a cable
or satellite television receiver.

SIF
Standard Image Format. For video, the SIF NTSC is 352 x 240 pixels, and

the SIF PAL is 352 x 288 pixels.

smoother
An algorithm that Helix Mobile Producer uses to regulate bit rates in

streaming media and prevent unexpected peaks or bursts in the data
streams. The smoother prevents media encoders from generating too
much data or overly complex data.
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stream
The encoded media or scene description data in an MPEG-4 file. A media
stream consists of audio, video, or other multimedia content that is
transmitted across a computer network in a streaming or continuous
manner.

streaming
The delivery of a media stream from a steaming server to a media player
(such as RealOne Player) as a steady, continuous flow of audio, video, or
other data. The player reconstructs each media scene by using
information stored in the scene description.

URL
Uniform Resource Locator. A standard, worldwide protocol for naming
documents or sites (such as Web pages) on the Internet.

VBR
Variable bit rate.

VTR
Videotape recorder.
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A AMR-NB, 113 CBR, 48, 51

AMR-WB, 113 channel capacity, 28

announce file, 102 CIF, 4

audio codec compatibility, 113, 114
average bit rate, 28 Codecs
bit rate, 28, 54 high response, 107
encoder type, 53 codecs, 8, 113
quality, 28 color adjustment, 63
use joint stereo, 55 colors, 63

audio bit rate, 54 combined media bit rate, 28
average, 28 command line, 73

audio codecs command-line flags, 73, 74

ARG, 113 command-line interface, 4, 73, 74
AMR-NB, 113 )

AMR-WB, 113 constant bit rate, 48

MP3, 113

QCELP, 113 D  data packet, 7, 34

RealAudio, 113 decoder, 120

audio encoding formats, 53 device compatibility, 114

AV|, 4 DiFeCtShOW, 4, 11
divide ratio, 64

B  batch processing, 85 double pass encoding, 52

batch processor, 85 double-pass encoding, 3

bit rate, 28, 55 Dv, 4
audio, 28
channel capacity, 28 E  encoding
combined media, 28 partial, 23
maximum streaming, 28 process, 18
bit-rate smoother, 28, 51 start, 22
broadcast modes export file formats, 12
Helix broadcast mode, 22 export parameters
RTP broadcast mode, 22 Maximum packet size, 66
burstiness, 51 progressive-download profile, 66

streaming-server profile, 65

C capture devices, 12, 21
capture sources, 21, 96 F file format compatibility, 113
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file formats
3GPP, 113
3GPP2, 113
AMR; 113
MP3, 113
MPEG-4, 113
QCELP, 113
RealMedia, 113
see also AVI
see also DV
see also MOV
see also WAV
file types
see file formats
filter
brightness, 63
color adjustment, 63
gamma correction, 63
frame rate, 8, 58, 64
frames
per second, 58, 64

Helix Server, 1, 5, 36
Helix Universal Server, 10
High response, 107

hint track, 65, 120

import file formats, 11
Input preview panel, 21
install

SNMP service, 115
installation, 13
installer, 13
interleave, 67, 68, 119

JavaScript, 5
job, 87
joint stereo, 55

leaky bucket, 51
length

presentation, 28
live encoding, 1, 19, 21

mark-in, 23
mark-out, 23
max keyframe distance, 58
maximum

streaming bit rate, 28
maximum packet size, 66

maximum transmission unit, 66

media, 17

metadata, 66

monitor via SNMP, 115
MOV, 4

MTU, 66

networking standards
ARCNet, 68
Ethernet, 68
FDDI, 68
HIPPI, 68
IEEE, 68
ISDN, 68

NTFS, 11

offline encoding, 19, 20

packets, 7
prefiltering, 4
presentation
length, 28
preview panels, 17

progression bar
job, 87

progressive-download profile, 66

protocols
IP, 68
PPPOE, 68
RTP, 68
RTSP, 68
RTSP interleave, 68
TCP, 68
UDP, 68
see also SLIP
see also TCP/IP

push broadcast, 38



QQCIF, 4

quality

audio, 28

video, 28
QuickTime, 1,4, 10
Quicktime, 11

RealMedia, 1, 12 X
RealPlayer, 7, 9

RealVideo, 114

RTP streaming, 12

single pass encoding, 52
single-bit-rate streaming, 9
size

presentation, 28
SLIP, 68
smoother, see also bit-rate smoother, 28, 51
SNMP service

installation, 115
specifications, 11
streaming server, 28
streaming-server profile, 65
SureStream, 28

target frame rate, 64
TCP/IP, 121
technical support, 5
token bus, 68

token ring, 68
tracks, 47

use joint stereo, 55

variable bit rate, 48
VBR, 48, 51
VBScript, 5
VBV, 51
video
quality, 28
video buffering verifier, 51
video encoding
max keyframe distance, 58

Index

variable bit rate, 48
video encoding formats, 56

WAV, 4
Windows Media, 1
Windows Media Player, 10

XML, 4, 74
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